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ÖZET 

UZAKTAN ALGILAMA VE COĞRAFİ BİLGİ SİSTEMLERİNDEN 

YARARLANARAK ÇOK KRİTERLİ KARAR VERME YÖNTEMİ İLE TAŞKIN 

RİSK HARİTASININ OLUŞTURULMASI: MALATYA İLİ ÖRNEĞİ 

İklim değişikliğinin en önemli etkilerinden biri olan taşkınlar, son yıllarda yıkıcılığı ve sıklığı 

artan afetlerdendir. Yağış rejimindeki anomaliler, ormanların tahribi ve hızla artan çarpık 

kentleşme ani taşkınların oluşmasına sebep olmaktadır. Afetlerin tahminine ve önlenmesine 

yönelik yapılan planlama çalışmalarında Coğrafi Bilgi Sistemleri (CBS) ve Uzaktan Algılama 

(UA) teknolojileri önemli rol oynamaktadır. Bu çalışmada CBS ve UA teknolojilerinden 

yararlanarak Çok Kriterli Karar Verme (ÇKKV) modeli ile Malatya ilinin taşkın risk haritası 

oluşturulması amaçlanmıştır. Yapılan çalışmada risk haritasından hareketle bölgenin risk 

sınıflaması çok yüksek riskli, yüksek riskli, orta riskli, az riskli ve çok az riskli olmak üzere 

beşe ayrılmıştır. Şehirleşmenin yoğun olduğu alanlar çok yüksek risk grubundadır. Risk 

altındaki bölgeler belirlenerek taşkının nüfus ve yapılar üzerindeki etkisi açıklanmıştır. En 

çok etkilenen nüfus şehirleşmenin yoğun olduğu alanlarda iken en çok etkilenen yapılar 

arasında konutlar ve kamu binaları bulunmaktadır. Elde edilen sonuçlardan hareketle 

çalışmada yöneticilere ve planlamacılara taşkınların önlenmesine yönelik önerilerde 

bulunulmuştur. 

Anahtar Kelimeler: Taşkın Riski, Coğrafi Bilgi Sistemleri, Uzaktan Algılama, Malatya. 
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ABSTRACT 

CREATING FLOOD RISK MAP WITH MULTI CRITERIA DECISION MAKING 

METHOD USING REMOTE SENSING AND GEOGRAPHICAL INFORMATION 

SYSTEMS: THE CASE OF MALATYA PROVINCE 

Floods, which are one of the most important effects of climate change, are one of the disasters 

that have increased in destructiveness and frequency in recent years. Anomalies in the rainfall 

regime, destruction of forests and rapidly increasing distorted urbanization lead to the 

formation of sudden floods. Geographical Information Systems (GIS) and Remote Sensing 

(RS) technologies play an important role in planning studies aimed at predicting and 

preventing disasters. In this study, it is aimed to create a flood risk map of Malatya province 

with a Multi-Criteria Decision Making (MCDM) model using GIS and RS technologies. In 

the study, based on the risk map, the risk classification of the region is divided into five 

districts which has very high risk, high risk, medium risk, low risk and very low risk. Areas 

where urbanization is intense are at a very high risk group. The effect of the flood on the 

population and structures has been explained by determining the regions at risk. The most 

affected districts are in areas where urbanization is intense, while housing and public 

buildings are among the most affected structures. Based on these results, recommendations 

for flood prevention were made to managers and planners in the study. 

Keywords: Flood Risk, Geographic Information Systems, Remote Sensing, Malatya. 
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1. GİRİŞ 

Doğal kaynaklar insan etkisi dışında oluşan zenginliklerdir. Doğal kaynakların başında 

gelen su, insan yaşamının bir gereksinimi olmakla beraber ekonomik, toplumsal ve kültürel 

yaşamın da vazgeçilmezidir.  

Su, en önemli doğal kaynaklardan biri olarak insanoğlunun varoluşundan bu yana 

yaşam kaynağı olarak seçilmiştir. Su, insanlar tarafından sadece biyolojik bir ihtiyaç olarak 

görülmemiş ve yaşamın merkezinde de olduğu için çevresel, ekonomik, toplumsal ve kültürel 

yaşamlarında da görülmektedir. 

Dünya üzerinde artan nüfusla beraber yaşanan ekonomik gelişmeler, sanayileşme, 

kentleşme gibi sebepler suya olan talebi artırmakta ancak var olan su rezervlerini de tehdit 

etmektedir. Sürekli artan nüfus, su kaynaklarını hızla ve yanlış bir şekilde tüketmektedir. 

Özellikle kentleşme ve sanayileşmenin neden olduğu kirlenmeler su kaynaklarını 

kullanılamaz hale getirmiştir. Nüfus artışıyla beraber yanlış yapılaşmalar, akarsu yataklarının 

kurutulup yerleşime açılması, su kaynaklarına insan müdahaleleri ve benzeri durumlar su 

kaynakları başta olmak üzere doğadaki kaynakların yok olmasına sebep olmaktadır. Doğadaki 

kaynakların yok olması birçok afete sebep olmakta ve bu durum hem doğanın hem insanların 

hem de diğer canlıların zarar görmesine yol açmaktadır.  

Günümüzde küresel ısınma, iklim değişikleri ve insan müdahalelerinin etkisiyle dünya 

genelinde yaşanan afet sayısında artışlar görülmektedir. Yangın, heyelan, çığ, toprak kayması, 

taşkın, fırtına, sel, deprem, vb. afetler dünya genelinde görülen afetlerden bazılarıdır.  

Dünyayı ve insanlığı tehdit eden tehlikelerin en önemlisi iklim değişikliğidir. Küresel 

çapta meydana gelen değişimler, aşırı sıcaklık, kuraklık ve taşkın gibi olaylar yeryüzündeki 

tüm canlıları tehdit etmektedir. 19. yüzyıldan itibaren artan sanayileşme süreci bu değişikliğin 

etkilerini artırmıştır. Fosil yakıt kullanımı, doğal kaynakların bilinçsizce tüketimi ve sanayi 

kirliliği gibi sebepler 20 ve 21. yüzyılda bu değişikliğin etkilerini gözler önüne sermiştir.  

 İklim değişikliğindeki en önemli sorun yağış rejimindeki düzensizlikler ve ani şiddetli 

yağışlardır. Bu düzensizlik ve ani yağışların beraberinde getirdiği taşkınlar birçok kayba yol 

açmaktadır. Taşkınların sebep olduğu kayıpların arasında can, mal, ekonomik, sosyal ve 

ekolojik kayıplar yer almaktadır. 

Taşkınlar dünyanın birçok yerinde zararlara yol açmaktadır. Ülkemizde de taşkınlar 

tarih boyunca birçok zarara sebep olmuştur. Ülkemizde doğal afetlerdeki en çok can ve mal 

kaybı depremlerde görülmekle beraber ikinci sırada sel ve taşkınlar yer almaktadır. 
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Toplumlar üzerindeki olumsuz etkileri nedeniyle taşkınlar günümüzde araştırmacıların 

çalışmalarında bir öncelik oluşturmaktadır. 2021 yılında yapılan bir çalışmaya göre 1979 ile 

2020 yılları arasında taşkınla ilgili yapılan çalışmaların sayısında ciddi bir artış gözlenmiştir 

(Costache vd., 2021). 

Günümüzde potansiyel bir taşkının tahmin edilmesi olası can ve mal kaybının önüne 

geçmek, zarar görebilecek bölgelerin belirlenmesi ve buna yönelik önlemlerin alınabilmesi 

açısından büyük önem kazanmaktadır. 

Taşkınların sebep olduğu zararları önlemek için dünyada olduğu gibi ülkemizde de 

son yıllarda çeşitli taşkın planlamaları, meteorolojik gözlemler, taşkın önleyici set ve 

barajların yapımı gibi çalışmalar görülmektedir. 

Dünyada birçok çalışmada Coğrafi Bilgi Sistemleri (CBS) ve Uzaktan Algılama (UA) 

teknolojileri kullanılmaktadır. Ülkemiz de birçok alanla birlikte su kaynakları yönetimi ve 

taşkınla ilgili çalışmalarda bu teknolojilerden yararlanmaktadır. 

Bu çalışmada Coğrafi Bilgi Sistemleri ve Uzaktan Algılama teknolojileri ile ArcGIS 

10.2 yazılımı kullanılarak Malatya ili taşkın risk haritasının oluşturulması, Coğrafi Bilgi 

Sistemleri ve Uzaktan Algılama teknolojileri kullanılarak daha pratik ve ekonomik olması 

amaçlanmıştır.  
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2. LİTERATÜR ÇALIŞMASI 

Elbaşı (2022), ülkemizin taşkın görülme sıklığı fazla olan Doğu Karadeniz 

Havzası’nda yaptığı bölgesel bir çalışmada CBS teknolojilerinden yararlanarak meydana 

gelebilecek taşkınların tahmininde bulunmuş ve bu taşkınlardan hangi alanların 

etkilenebileceğini ortaya koymuştur. 

Bayazıt (2021a), Bilecik ilinde yaptığı çalışmada 2000 ile 2018 yıllarının Çevresel 

Bilginin Koordinasyonu (CORINE - Coordination of Information on the Environment)  arazi 

kullanım haritalarını ve taşkın oluşumunda etkili yağış, eğim, arazi kullanımı, yükseklik ve 

akarsulara uzaklık kriterlerini kullanarak CBS ve UA teknolojileri ile ArcGIS 10.5 yazılımı 

üzerinden Çok Kriterli Karar Verme Yöntemi (ÇKKV) ile şehirleşmenin taşkınlar üzerindeki 

olumsuz etkisini vurgulamıştır. 

Öztürk ve ark. (2021) Düzce bölgesinin coğrafi yapısı nedeniyle taşkınlara sık maruz 

kalmasını göz önünde bulundurarak yaptıkları çalışmada, CBS’den yararlanarak son 

zamanlarda kullanılan ÇKKV yöntemlerinden Analitik Hiyerarşi Süreci (AHP) ile Düzce 

bölgesi için taşkın risk haritası oluşturmuşlardır. Bu çalışmada uzun dönem yağış verileri ile 

birlikte eğim, bakı, akarsulara uzaklık, jeoloji, arazi kullanım ve toprak haritaları gibi 

kriterleri değerlendirerek taşkın üzerindeki etkisini incelemişleridir.  

Tüzgen ve Karaca (2021), Muğla-Fethiye’de yer alan Çerçi Deresi üzerinde yaptıkları 

çalışmada eğim, yükseklik, arazi kullanımı, akarsulara yakınlık, jeoloji, bakı kriterlerini tek 

tek ele alarak değerlendirmiş ve Çerçi Deresi’nin taşkın duyarlılık haritasını CBS’den 

yararlanarak ÇKKV yöntemi ile oluşturmuşlardır. Bu çalışma ile taşkından etkilenebilecek 

alanların belirlenmesi amaçlanmıştır. 

Desalegn ve Mulu (2020), yaptıkları çalışmada Etiyopya Amhara’da Banja, Sekela, 

Bure, Guagusa Shikudad ve Womberma bölgelerinin yer aldığı Fetam Havzası’nın ve 

nehrinin taşkın riskini değerlendirmişlerdir. Çalışmada CBS ve HECRAS ile Analitik 

Hiyerarşi Süreci (AHP) kullanılarak farklı kriterlerin karar vermedeki etkisi 

değerlendirilmiştir. Arazi örtüsü, yükselti, drenaj yoğunluğu, yağış, toprak türleri ve eğim 

faktörlerini dikkate almışlardır. Fetam Havzası’nın taşkın risk haritasının oluşturulması ile 

CBS ve HECRAS gibi yazılımların, taşkın alanlarını ve taşkınların vereceği zararları önceden 

belirleyip önlem almak için kullanılabilir yazılımlar olduğunu belirtmişlerdir. 
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Swain ve ark. (2020), Hindistan'ın Bihar kenti için hidrolojik, morfometrik, 

geçirgenlik, arazi örtüsü dinamikleri ve 21 alt kriteri içeren antropojenik müdahale kriterleri 

olmak üzere beş ana kriter ile CBS ve AHP’den yararlanarak taşkın risk haritası 

oluşturmuşlardır. 

Günseli (2019), küresel ısınma ve iklim değişikliğinin taşkınlar üzerindeki etkisini 

vurgulayarak İzmir Menemen Ovası’nda yaptığı çalışmada, kentleşme ve sanayileşmenin de 

taşkınlar üzerindeki olumsuz etkisini değerlendirmek amacıyla kullandığı eğim, yükseklik, 

nehirlere uzaklık, arazi kullanımı ve yağış kriterlerini ArcGIS 10.2 yazılımında ÇKKV 

metotlarından AHP kullanarak değerlendirmiş ve taşkın riski taşıyan yerleri sınıflandırmıştır. 

Taşkın risk yönetiminin kamu-özel-birey birlikteliği içinde yönetilmesi gerektiğine 

değinmiştir. 

Tanrıverdi (2019), Şanlıurfa il merkezinde bulunan Sırrın, Karakoyun ve Cavsak 

derelerini esas alarak, olası taşkın alanlarını belirlemek ve il merkezindeki konut, sağlık, 

eğitim ve sanayi gibi alanların ne kadarının risk altında olduğunu değerlendirmek amacıyla 

CBS’den yararlanarak ÇKKV yöntemi ile taşkın risk haritası oluşturmuştur. Yağış, yükseklik, 

jeoloji, eğim, bakı, arazi kullanımı, akarsulara uzaklık verilerinden elde ettiği haritaları 

birleştirerek taşkın risk haritası oluşturmuştur. 

Yurdakul (2019), Sakarya ilinin Sapanca ilçesinde yer alan Keçi Deresi’nde yaptığı 

çalışmada farklı tekerrürlerde meydana gelebilecek taşkınların risk analizini yaparak yapısal 

ve yapısal olmayan önlemlerin alınması için çözüm önerisinde bulunmuştur. 

Tokgözlü ve Özkan (2018), Antalya Aksu Çayı Havzası’nda yaptıkları çalışmada 

taşkında etkili arazi kullanımı, eğim, bitki örtüsü, yağış, toprak, akarsulara uzaklık, litoloji 

gibi faktörleri ArcGIS 10.4 yazılımında kullanarak taşkın risk haritası oluşturmuşlardır. 

Kullanılan parametrelerin önem dereceleri AHP ile belirlenmiştir. Çalışma, taşkın 

çalışmalarında kullanılabilen bu yöntemin tüm faktörlerin doğru bir şekilde belirlenip 

aralarındaki ilişkinin doğru derecelendirilmesi ve tutarlılığı açısından önem taşımaktadır. 

Rincon ve ark. (2018), Büyük Toronto Bölgesi’ndeki Don Nehri havzasında yaptıkları 

çalışmada taşkın risk haritaları için güvenilir ve basit bir yöntem sağlamayı amaçlamışlardır. 

Bu amaçla su kaynakları ile ilgili karar verme problemlerini çözmek için yaygın olarak 

uygulanan AHP ile birlikte CBS ve ÇKKV yöntemini kullanmışlardır. Taşkın risk haritasını 

oluşturmak için eğim, akarsulara uzaklık, toplam yağış, etkili yağış,  akış eğri numarası, 

taşkın yatağı haritası, en yakın drenaj noktasının üzerindeki yükseklik kriterleri kullanılmıştır. 
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Hangi kriterlerin en uygun olduğunu belirlemek için kriterlerin farklı kombinasyonları ile dört 

senaryo oluşturulmuştur. Birinci senaryo, hidrolojik ve hidrolik modellere dayalı olması 

nedeniyle temel kriterleri (akarsulara uzaklık, en yakın drenaj noktasının üzerindeki 

yükseklik, eğim, eğri numarası) ve taşkın tehlike haritasında en etkili kriter olan taşkın yatağı 

haritasını içerdiğinden temel durum olarak seçilmiştir. İkinci senaryo, birinci senaryo ile aynı 

temel kriterleri içerir, ancak taşkın yatağı haritasını içermez. Üçüncü senaryo; eğim, en yakın 

drenaj noktasının üzerindeki yükseklik, akarsulara uzaklık ve etkili yağışı içerir, ancak eğri 

numarasını içermez. Dördüncü senaryo; toplam yağışın yanı sıra temel kriterleri içerir.  İki, üç 

ve dördüncü senaryoları geliştirmenin amacı, birinci senaryoda ayrıntılı taşkın yatağı 

haritasını kullandığından, birinci senaryo haritasıyla karşılaştırılabilir genel taşkın risk 

haritalarını yapıp yapamayacaklarını belirlemektir. Bu haritalar gerçekten karşılaştırılabilir 

ise, önerilen yaklaşımın birinci senaryoya kıyasla nispeten düşük veri gereksinimleriyle 

faydalı araçlar oluşturabileceğini gösterecektir. Sonuçlar ikinci senaryoda oluşturulan 

haritanın birinci senaryo haritasına en yakın olduğunu göstermiştir. Bu, ikinci senaryo için 

kullanılan basit kriterlerin birinci senaryoda oluşturulan sel tehlike haritalarını yeterince 

üretebileceği anlamına gelir. Çalışmanın sonuçları, taşkın tehlikesi haritalaması için sadece 

akarsulara olan mesafe, eğim, en yakın drenajın üzerindeki yükseklik ve eğri numarası 

kriterlerinin güvenilir haritalar elde etmek için yeterli olduğunu göstermektedir. Bununla 

birlikte, yağış verileri dahil edilirse, toplam yağışı kullanmak yerine etkin yağışı kullanmak 

daha iyidir. 

Özkan (2017), Antalya Havzası’nın on alt havzasından biri olan Aksu Çayı 

Havzası’nın taşkın durumunu CBS teknolojilerinden yararlanarak belirlemek istemiştir. 

Çalışmasında kullandığı arazi kullanımı, yağış, toprak, eğim, litoloji ve akarsulara uzaklık 

kriterlerini kullanarak AHP ile ArcGIS 10.4 yazılımında haritalandırmıştır. 

Tehrany ve ark. (2017), Çin’in Jiangxi eyaletinin güneyinde yer alan Xing Guo 

bölgesinin taşkın risk haritasının oluşturulmasında frekans oranı (FR), lojistik regresyon (LR) 

ve kanıt ağırlığının (WoE) tahmin performanslarını değerlendirmek amacıyla CBS 

teknolojilerinden yararlanarak bir çalışma yapmışlardır. Yükseklik, eğim, bakı, jeoloji, 

nehirden uzaklık, yoldan uzaklık, faydan uzaklık, toprak tipi, arazi kullanımı/örtü, yağış, 

Normalleştirilmiş Fark Bitki Örtüsü İndeksi, Akarsu Gücü İndeksi, Topografik Islaklık 

İndeksi, Sediment Taşınma İndeksi ve eğrilikten oluşan 15 kriter kullanmışlardır. WoE'nin FR 

ve LR yöntemlerine kıyasla eğilimli alanların haritalanması için daha gelişmiş bir yöntem 

sunduğu sonucuna varılmıştır. 
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Oğuz ve ark. (2016), Coğrafi Bilgi Sistemleri’nden yararlanarak yağış, jeoloji, eğim, 

bakı gibi faktörleri analiz kapsamında değerlendirerek Artvin ilinin taşkın risk haritasını 

belirlemişlerdir. Yapılan çalışmada analiz sonuçları ve oluşturulan haritalar çakıştırılarak 

bölgedeki taşkının etkileyeceği riskli alanlar belirtilmiştir. Ayrıca çalışma alanındaki 

akarsuların çatallanma oranları ve drenaj yoğunlukları da hesaplanmıştır. 

Demir ve Kişi (2015), yaptıkları çalışmada samsun ili mert nehri havzası için CBS ve 

HECRAS kullanarak taşkın tehlike haritaları oluşturmuşlardır. Topografik verileri 

sayısallaştırılarak ArcGIS ile Sayısal Yükseklik Modeli (SYM) hazırlamışlardır. Sonra 

HECRAS ile farklı periyotlardaki (10, 25, 50, 100 ve 1000 yıl) taşkın akışlarını simüle 

etmişlerdir. Daha sonra ise ArcGIS ve HECRAS sonuçlarını birleştirerek taşkın risk haritaları 

elde etmişlerdir. 

Nas ve Nas (2015), Gümüşhane’de yaptıkları çalışmada CBS ve UA teknolojilerini 

küresel veri tabanlarıyla birlikte kullanarak meydana gelebilecek bir taşkının ilin altyapı 

tesislerine etkilerini araştırmışlardır. 

Saral ve Musaoğlu (2011), yapmış oldukları çalışmada taşkın risk analizine yönelik 

yazılım üretmeyi amaçlamışlardır. Coğrafi Bilgi Sistemleri ve Uzaktan Algılama teknolojileri 

bu yazılımın elde edilmesinde önemli birer araç olmuştur. Çalışmada Analitik Hiyerarşi ve 

Bilgi Difüzyonu yöntemleri kullanılmıştır. Çalışma alanı olarak İstanbul Ayamama deresi 

seçilmiştir. Yazılımın harita üretimi için ArcGIS Engine kullanılmıştır. Elde edilen veriler 

Bilgi Difüzyonu ve AHP ile değerlendirildikten sonra oluşturulan yazılım ile Ayamama 

Deresi’nin risk haritası oluşturulmuştur. Oluşturulan yazılım, doğru veriler ışığında taşkın ile 

ilgili herhangi bir problemin çözümünde kullanılabilir hale getirilmiştir. 

Şahin ve Kavzoğlu (2011), Trabzon ilinde yaptıkları çalışmada heyelan riski taşıyan 

yol güzergâhlarının tespiti ve bu güzergâhlarda heyelandan dolayı meydana gelebilecek 

zararlara karşı alınabilecek önlemler için yeryüzünün farklı karakteristiklerini içeren verilerin 

toplanmasında CBS’den yararlanmışlardır. Çalışmada eğim, litoloji, bakı, arazi türü, 

yükseklik, topoğrafik ıslaklık indeksi ve drenaj yoğunluğu olmak üzere yedi farklı 

parametrenin önem dereceleri AHP ile belirlenerek kriter ağırlıkları hesaplanmıştır. 

Kullanılan kriterler önem derecesine göre sıralanarak ÇKKV metodu ile heyelan duyarlılık 

haritası oluşturulmuştur.  
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3.TAŞKIN 

Taşkın, bir akarsuyun çeşitli sebeplerle yatağından taşıp çevresindeki yapılara, 

arazilere ve canlılara zarar verecek biçimde akışa geçmesidir (OSİB, 2017a). 

3.1 Taşkınları Etkileyen Etmenler 

Taşkınların oluşumunu etkileyen etmenler doğal ve beşeri etmenler olarak ikiye 

ayrılır: 

3.1.1 Doğal Etmenler 

İnsan etkisi dışında, kendiliğinden gerçekleşen etmenlere denir. Bu etmenler iklim, 

bitki örtüsü, eğim, yükseklik, drenaj alanının özellikleri, zeminin doygunluğu ve bakı olarak 

sınıflandırılabilir. 

3.1.1.1 İklim  

Taşkınları etkileyen en önemli etkenlerden biri olan iklim parametreleri yağış, 

sıcaklık, buharlaşma, nem, basınç ve rüzgâr olarak sıralanabilir. En etkili parametreler yağış 

ve sıcaklık iken basınç, buharlaşma, nem ve rüzgârlar diğer parametrelere göre daha az 

etkilidir. 

Taşkına sebep olan yağış türleri yağmur, kar veya dolu olarak sıralanabilir. Taşkına 

sebep olan yağışlar cephesel (frontal), orografik (yamaç) ve konveksiyonel (yükselim) 

yağışlardır. Şekil 3.1’de yağışın oluşum şekilleri verilmiştir. 

 

 

 

 

 

 

 

 

                                           
 
                                                                                                
                                                                                                
 

                                                    
 
a) Konveksiyonel Yağış  b) Orografik Yağış   c) Frontal Yağış 

Şekil 3.1. Yağışın Oluşum Şekilleri 
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Yağışların uzun sürmesi akarsu yatağındaki suyun yükselmesine, debinin artmasına 

neden olur ve taşkınlar meydana getirir. Aynı zamanda şiddetli yağışlar da debiyi artırarak 

taşkınlara yol açmaktadır. 

İlkbahar mevsiminde sıcaklıkların artmasıyla beraber karlar eriyerek akarsulara 

karışmaktadır. Akarsulara karışan kar debiyi artırınca, akarsu taşıyamayacağı debiye gelerek 

taşkınlara sebep olmaktadır. 

Dolu yağışının sebep olduğu taşkınlar ise dolunun erime hızıyla ilgilidir. Erime hızını 

etkileyen faktör ise sıcaklıktır. Daha kısa sürede bir erime gerçekleşir ve ani debi 

yükselmesine bağlı olarak taşkınlara sebep olur. 

İklim parametrelerinden bir diğeri de sıcaklıktır. Sıcaklığın değişimi yağış türünü 

etkilemektedir. Sıcaklığın düşük olduğu yerlerde kar yağışları görülürken daha yüksek 

sıcaklıklarda yağmur görülmektedir. Ülkemizde Doğu Anadolu Bölgesi’nde düşük 

sıcaklılardan dolayı kar yağışları görülmektedir. İlkbahar mevsiminde karlar eriyerek akışa 

geçmekte ve akarsularla birleşip debiyi artırmaktadır. Eriyen karların bir kısmı da 

buharlaşarak yağmura dönüşmektedir. Kar erimesi ve yağmurların birleşmesiyle akarsu 

yatakları taşmaktadır.  

Bu parametrelerin yanı sıra basınç, nem ve rüzgârlar da taşkınları dolaylı olarak 

etkileyen diğer etmenlerdir. 

3.1.1.2 Bitki Örtüsü 

Bitki örtüsünün bulunmağı alanlarda suyun akışını azaltacak veya durduracak bir şey 

olmadığı için suyun akışı hızlı olur ve taşkının çevreye zararı daha fazla olur. Fakat bitki 

örtüsü bulunan yerlerde su bitki örüsünün bünyesine girdiği için suyun zemindeki akışı 

yavaşlar. Bitki örtüsü böylece taşkının etkisini azaltır. 

3.1.1.3 Eğim 

Taşkınları etkileyen önemli faktörlerden biri de eğimdir. Eğimin yüksek olduğu 

yerlerde yağışla düşen su sızmadan akışa geçecektir ve akış hızıyla birlikte toplanma süresi 

artacaktır. Bu durumda akışa geçen suyun fazla olduğu yerde taşkın riski de artacaktır.  

3.1.1.4 Yükseklik  

Yükseklik yağış türünü etkilediği için taşkın için önemli bir faktördür. Düşen yağış 

arazide yüksek kottan düşük kota akışa geçer. Taşkınlar ise düşük kotlarda daha fazla 

görülmektedir. 
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3.1.1.5 Drenaj Alanının Özellikleri 

Drenaj alanının özellikleri, taşkının hacmini ve pik değere ulaşma süresini etkileyen 

faktörlerdendir. Alanları aynı, şekilleri farklı olan iki drenaj alanında meydana gelecek 

taşkının pik süresi ve hacmi farklı olacaktır. Uzun ve dar olan bir drenaj alanında taşkının 

toplanma süresi daha uzun, debisi daha küçük iken kısa ve geniş bir yapıya sahip drenaj 

alanında bu süre daha kısa ve debi ise daha büyük olacaktır.  

3.1.1.6 Zeminin Doygunluğu 

Kar ve yağmur sularını bünyesine alan zemin yeterli doygunluğa ulaşmış ise bir 

sonraki yağışla gelen suları bünyesinde tutamaz ve su yüzey akışına geçer. Bölge bitki örtüsü 

bakımından da fakir ise düşen yağışlarla birlikte taşkın eğilimindedir. Özellikle ilkbahar 

mevsiminde kar erimeleri, kış mevsiminde yağışlar nedeniyle zemin yeterince doygun olduğu 

için fazla suyu emmeyecek ve akışa geçirecektir. 

3.1.1.7 Bakı 

Sıcaklığın daha yüksek olduğu bakı yönündeki yamaçlarda kar erimeleri diğer 

yamaçlara göre daha hızlı gerçekleşir ve akarsuya daha çabuk ulaşır. 

3.1.2 Beşeri Etmenler 

İnsan etkisi ile gerçekleşen etmenlerdir. Kentleşme, arazi kullanımı, orman ve bitki 

örtüsünün tahrip edilmesi, baraj yıkılması olarak sınıflandırılabilir. 

3.1.2.1 Kentleşme 

Günümüzde taşkınlara sebep olan en önemli beşeri faktör kentleşmedir. Nüfusun hızla 

artmasına paralel olarak kontrolsüz yapılaşma sırasında bitki örtüsünün ve toprağın 

tahribatıyla zeminin geçirgenliği azalmakta ve geçirimsiz yüzeyler meydana gelmektedir. 

Yağışların yer altına sızması gerekirken yüzeyde akışa geçmesi zeminin akış katsayısını 

artırmakta ve bu da taşkın riskini artırmaktadır. 

Kentleşme sırasında plansız yapılaşma, akarsu yatağının yönünün değiştirilmesi ve 

önünün kesilmesi, kesiti yetersiz sanat yapılarının yapılması, taşkın kontrol yapılarının 

planlanmaması gibi faktörler de taşkın riskini artırmaktadır. 
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3.1.2.2 Arazi Kullanımı 

Eğimli arazilerin yanlış sürülmesi, teraslama yapılmaması, ekilen bitkilerin düzgün 

sıralanmaması, tarım alanlarının nadasa bırakılması, yanlış sulama teknikleri gibi uygulamalar 

taşkını etkileyen faktörlerdir. 

3.1.2.3 Orman ve Bitki Örtüsünün Tahrip Edilmesi 

Orman ve bitki örtüsünün tahrip edilmesi ile toprağın su tutma kapasitesi azalmakta ve 

yağış yüzeyde akışa geçmektedir. Akışa geçen su miktarı artınca beraberindeki toprağı da 

sürükleyerek erozyona neden olmaktadır. Erozyon sonucunda katı maddeler birikerek suyun 

akışını etkileyip taşkına sebep olmaktadır. 

3.1.2.4 Baraj Yıkılması 

Barajlar taşkınların kontrolünde kullanılabilen yapılarıdır. Barajın gelen suyu 

karşılayamaması sonucunda gövdesine etki eden kuvvet normal kuvvetten daha fazla olur. 

Bunun sonucunda dolu savak yetersiz kalabilir, barajın gövdesinde muhtemel hasarlar 

oluşabilir ve yıkılma tehlikesiyle karşı karşıya kalan baraj taşkınlara sebep olabilir (Yaylak, 

2016). 

3.2 Taşkın Türleri 

Taşkınlar genel olarak üç sınıfa ayrılır. 

3.2.1. Oluşum Süresine Göre Taşkınlar 

3.2.1.1 Ani Taşkınlar 

Şiddetli ani yağışlar, buzul hareketleri ve baraj yıkılmaları gibi ani bir sebeple 6 saat 

içinde meydana gelen taşkınlardır. 

3.2.1.2 Uzun Süreli Taşkınlar 

Bir hafta veya daha uzun sürede meydana gelen taşkınlardır. Yağışın ani akışa 

geçmeden topraktan süzülerek yavaş ve düzenli bir şekilde akışa geçmesi ile oluşan 

taşkınlardır. 

3.2.2. Oluş Zamanına Göre Taşkınlar 

3.2.2.1 Yaz Taşkınları 

Yaz mevsiminde sağanak yağışlar sebebiyle veya kar, buz erimeleri sebebiyle 

meydana gelen taşkınlardır. 
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3.2.2.2 Kış Taşkınları 

Kış aylarında sürekli ve uzun süreli yağışlar sebebiyle zemin doygun hale gelir. Bu 

yağışlar büyük hacimli akışlara neden olur. Kasım-Mart ayları arasında görülen taşkınlardır. 

3.2.2.3 İlkbahar Taşkınları 

İlkbahar aylarında kar erimeleri sonucunda oluşan taşkınlardır. 

3.2.3. Oluş Yerine Göre Taşkınlar 

3.2.3.1. Dere ve Nehir Taşkınları 

Uzun süreli yoğun yağışlar, kar/buz erimeleri, baraj yıkılması, koruyucu yapıların 

tahribi gibi sebeplerle meydana gelen taşkınlardır. 

3.2.3.2. Şehir Taşkınları 

Şehirleşmenin artmasıyla birlikte yer altına sızan su miktarı geçirimsiz zeminler 

sebebiyle azalmaktadır. Yanlış imar uygulamaları ve arazi kullanımları, kesiti daralan dere 

yatakları ve kanallar, tahrip edilen bitki örtüsü ve geçirimsiz zeminler taşkınlara sebep 

olmaktadır.  

3.2.3.3. Kıyı Taşkınları 

Fırtına, tsunami veya yüksek dalgalar sebebiyle deniz sularının kıyıya taşınmasıyla 

oluşan taşkınlardır. 

3.2.3.4. Dağlık Alan Taşkınları 

Şiddetli yağışlar, kar/buz erimeleri gibi nedenlerle dağlık alanlarda meydana gelen 

taşkınlardır. 

3.2.3.5. Yeraltı Suyu Taşkınları 

Uzun süreli yağışlarla birlikte toprağa kapasitesinden fazla suyun süzülmesi 

sonucunda yeraltı suyu seviyesinin yükselmesi ile meydana gelen taşkınlardır. 

3.2.3.6. Göl Taşkınları 

Göllerin seviye değişikliklerinden kaynaklanan taşkınlardır. 
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3.3. Taşkının Etkileri 

Taşkınların sebep olduğu en önemli zarar can kayıplarıdır. Dünya genelinde meydana 

gelen taşkınlar sebebiyle birçok can kaybı yaşanmaktadır. 20. yüzyılda dünya genelinde 

4.000’den fazla taşkın görülmüş ve yaklaşık 7 milyon can kaybı yaşanmıştır (Akhtar, 2013). 

Ülkemizde sık sık meydana gelen taşkınlarda yaşanan can kaybı sayısı çok yüksektir. 

2021 yılının Temmuz ayından itibaren Doğu ve Batı Karadeniz’de meydana gelen 

taşkınlardan dolayı can kaybı sayısı oldukça fazladır. 

Taşkınların bir diğer etkisi ise hayvanların telef olması ve sağ kalan hayvanlar için ise 

yaşam alanı kalmamasıdır. Ayrıca bitki örtüsünü tahrip ettiği için çevre dengesi 

bozulmaktadır. 

Taşkınların; evlerin, köprülerin, menfezlerin yıkılması, içme suyu şebekesinin tahrip 

olması, salgın hastalıklar, çevre kirliliği, zehirli ve atık maddelerin artması, bataklık alanların 

oluşması, erozyonla birlikte topraktaki verimin düşmesi, kuraklık, sosyoekonomik sorunlar 

gibi birçok zararlı etkisi bulunmaktadır. 

3.4. Taşkına Karşı Alınabilecek Önlemler 

Taşkınlara karşı alınabilecek önlemler yapısal önlemler ve yapısal olmayan önlemler 

olarak sınıflandırılabilir. 

3.4.1 Yapısal Önlemler 

Yapısal önlemler; baraj/biriktirme yapıları, seddeler, bentler, derivasyonlar, ayrık 

sistem kanalizasyonlar ve yatak düzenleme yapıları olarak sıralanabilir. 

3.4.2 Yapısal Olmayan Önlemler 

Taşkın tahmin ve uyarı sistemleri, taşkın yönetimi, taşkın yataklarındaki yerleşimin 

engellenmesi, yanlış arazi kullanımının önüne geçilmesi, taşkınlara ve diğer doğal afetlere 

karşı halkın bilinçlendirilmesi, arazi kullanım planlamaları, farkındalık yaratılması, taşkın 

sigortası vb. önlemlerdir. 
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3.5. Ülkemizde Meydana Gelen Taşkınlar 

Türkiye’de 1975 ile 2015 yılları arasındaki taşkınlar Tablo 3.1’de gösterilmiştir. 

Tablo 3.1. Türkiye’de 1975 ile 2015 Yılları Arasındaki Taşkınlar 

Taşkın 
Yılı 

Toplam 
Taşkın 
Sayısı 

Toplam 
Can Kaybı 

Su Altında 
Kalan Alan 

(ha) 

Taşkın 
Yılı 

Toplam 
Taşkın 
Sayısı 

Toplam 
Can Kaybı 

Su Altında 
Kalan Alan 

(ha) 
1975 62 8 36.714 1996 4 1 11.000 
1976 29 5 22.536 1997 1 0 1.390 
1977 27 11 3.317 1998 2 57 7.000 
1978 21 0 13.850 1999 1 3  
1979 21 61 40.966 2000 4 0 8.066 
1980 44 6 83.016 2001 42 8 43.297 
1981 16 2 58.413 2002 27 27 510 
1982 10 0 784 2003 21 7 64.200 
1983 14 33 2.113 2004 23 3 25.750 
1984 12 0 29.140 2005 25 14 13.855 
1985 7 0 2.318 2006 24 45 85.810 
1986 8 4 679 2007 22 11 1.050 
1987 7 0 564 2008 10 2 10 
1988 24 17 3.910 2009 84 59 3.250 
1989 10 1 9.500 2010 110 25 44.279 
1990 26 57 7.450 2011 56 13 202 
1991 23 23 15.770 2012 69 23 19.685 
1992 14 1 690 2013 38 7 17.569 
1993 2 0 60 2014 118 9 4.455 
1994 9 4 1680 2015 122 9 7.985 
1995 20 164 201.100 Toplam 1.209 720 893.933 

Kaynak: (OSİB, 2017b) 

Ülkemizde 2016 yılında 134, 2017 yılında 187, 2018’de 331 ve 2019’da 332 sel olayı 

yaşanmıştır. 

2000 yılından sonra sel ve taşkın olaylarında artışlar meydana gelmiştir. Son yıllarda 

ise meydana gelen taşkın ve sel sayısı yaklaşık 100 ve üzerindedir. Grafik 3.1’de görüldüğü 

gibi 1940 yılından 2020 yılına kadar yaşanan sel olayları göz önünde bulundurulursa en fazla 

sel afetinin yaşandığı üç yıl 2018, 2019 ve 2020’dir (MGM, 2021a). 
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Grafik 3.1. Ülkemizde 1940 İle 2020 Yılları Arasındaki Sel Afetinin Yıllara Dağılımı 

Kaynak: (MGM, 2021a) 

Meteoroloji Genel Müdürlüğü’nden elde edilen verilere göre ülkemizde 2020 yılında 

297 adet şiddetli yağış/sel olayı yaşanmıştır. MGM iklim raporuna göre 2021 yılında yaşanan 

doğal afetlerin %28’ini şiddetli yağış ve sel oluşturmaktadır. 2021 yılında Kastamonu ve 

ilçelerinde şiddetli yağış sebebiyle oluşan sel felaketinde 71 can kaybı yaşanmış ve birçok 

yapı kullanılamayacak hale gelmiştir. Ağustos 2021’de Sinop ve ilçelerinde sağanak yağışlar 

sebebiyle yaşanan sel felaketinde ise 10 can kaybı yaşanmış ve birçok yapı hasar görmüştür 

(MGM, 2022). 

3.6. Ülkemizde Taşkın Yönetimi 

Ülkemizde taşkın öncesinde, taşkın anında ve taşkın sonrasında yapılan çalışmalar ile 

ilgilenen çeşitli kurumlar ve kuruluşlar mevcuttur.  Bunlardan bazıları; 

1. Tarım ve Orman Bakanlığı  

Ülkemizdeki taşkın yönetiminden genel sorumlu kurumdur. Devlet Su İşleri Genel 

Müdürlüğü, Su Yönetimi Genel Müdürlüğü, Çölleşme ve Erozyonla Mücadele Genel 

Müdürlüğü ve Meteoroloji Genel Müdürlüğü ile beraber çalışmalar yapmaktadır. 

a) Meteoroloji Genel Müdürlüğü: Özel ve kamusal birimlere tedbir almaları için 

şiddetli meteorolojik olaylara ilişkin erken uyarı yapmak, duyurmak ve bu konuda 

araştırma geliştirme çalışmaları yapmak faaliyetleri arasındadır. 
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b) Devlet Su İşleri Genel Müdürlüğü: Taşkın yönetimi konusunda görevli önemli 

kurumlardandır. Taşkın anında ve sonrasında çalışmaları bulunmakla beraber 

ağırlıklı görevi taşkın öncesi faaliyetleri kapsamaktadır. Görevleri arasında strateji 

ve plan hazırlamak, eğitim faaliyetleri, il/bölge taşkın planı hazırlamak, imar 

planlaması için gerekli etütlerin hazırlanması, yaşanan taşkınlarla ilgili bilgileri 

raporlamak, akarsu yataklarını düzenleme, dere yataklarını temizleme, taşkın 

kontrol tesislerinin bakım onarımı, yoğun taşkın riski taşıyan alanların her türden 

yapılaşmaya yasak ilan edilmesi için ilgili çalışmalar yapmak ve ıslahı yapılan 

alanların revizesi gibi faaliyetler yer almaktadır.  

c) Çölleşme ve Erozyonla Mücadele Genel Müdürlüğü: Stratejiler ve politikalar 

belirlemek, sel kontrolü, heyelan kontrolü, yukarı havza sel eylem planı 

hazırlamak, havza ıslahı ile ilgili plan proje çalışmaları gibi faaliyetleri 

bulunmaktadır. 

d) Su Yönetimi Genel Müdürlüğü: Taşkınla ilgili yönetim planı hazırlamak, mevzuat 

hazırlamak, taşkına yönelik stratejilerin ve politikaların belirlenmesi, yönetim 

koordinasyonunu sağlamak faaliyetleri arasındadır. 

2. Afet ve Acil Durum Yönetimi Başkanlığı 

Afet öncesinde-anında-sonrasında yapılacak tüm faaliyetleri planlamak, uygulamak ve 

uygulanmasını sağlamak, diğer kurumlar ve kuruluşlarla işbirliğinde bulunmak ve 

koordinasyonun sağlanması, ilgili planları ve stratejileri geliştirmekten sorumlu kurumdur. 

İl düzeyinde ise tüm faaliyetlerden İl Afet ve Acil Durum Müdürlükleri sorumludur. 

İlgili faaliyetleri diğer kurum ve kuruluşlarla işbirliği halinde yürütmektedirler. 

3. Çevre, Şehircilik ve İklim Değişikliği Bakanlığı  

Arazi kullanımı, çevre düzenlemesi, kentsel dönüşüm, yerleşim alanları ve yapılaşma 

ile ilgili planlamalara yön veren ve ilgili kurumlarla işbirliği halinde çalışan kurumdur. 

4. Valiler  

Valilere bağlı bakanlıkların taşra teşkilatlarınca yürütülmekte olan taşkınların il 

düzeyindeki faaliyetlerinden sorumludur. 
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5. İl Özel İdareleri  

Yangın, deprem, sel ve diğer doğal afetlerle ilgili acil durum planlarının yapılması, 

gerekli donanım ve ekibin hazırlanması, halkın eğitilmesi vb. konularda ilgili kurumlarla 

işbirliği halinde çalışır. 

6. Büyükşehir Belediyeleri  

İmar planlarının hazırlanması, onaylanması, uygulanmasının denetimi, dere ıslahı, 

doğal afetlere hazırlık planları, gerektiğinde afet bölgesine araç ve ekip desteği sağlanması, 

can kaybı bakımından tehlikeli binaların tahliyesi vb. konularla ilgili sorumlulukları 

bulunmaktadır. 

7. Belediyeler  

Doğal afetlere hazırlık planlamaları, doğal afetlerin zararlarının azaltılması amacıyla 

ilgili planlamaların yapılması, ekip ve donanım hazırlanması vb. konularda diğer kurumlarla 

işbirliği halinde çalışmaktadır.  
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4.CBS VE UZAKTAN ALGILAMA 

4.1. Coğrafi Bilgi Sistemleri (CBS) 

4.1.1. Tanımı 

Günümüzde birçok karmaşık problemin çözümünde teknolojinin kullanımı 

gerekmektedir ve teknolojinin ilerlemesi ile beraber ortaya çıkan Coğrafi Bilgi Sistemleri 

birçok alanda kullanıldığı gibi su kaynakları yönetiminde de sıklıkla kullanılmaktadır.  

Burrough’a göre CBS, bir amaç doğrultusunda yeryüzündeki verilerin toplama, 

depolama, sorgulama, transfer etme ve görüntüleme işlevleri için kullanılan tüm araçlardır 

(Efe, 2013). 

CBS (Şekil 4.1), yeryüzündeki birtakım problemlerin (çevresel, sosyal, ekonomik) 

çözümüne yönelik ilgililere yardım amacıyla, verileri toplama, depolama, işleme, analiz, 

sorgulama ve sunma gibi işlevleri olan coğrafi veri ve yöntemler, yazılım, personel, donanım 

gibi elemanları bulunan teknolojilerdir. 

 

 

Şekil 4.1. CBS 

Kaynak: (Başarsoft, 2022) 
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4.1.2 CBS ve Tarihi 

Coğrafi Bilgi Sistemleri bir proje olarak Kanada’da 1963’te başlamış, 1970’te 

tamamlanmış ve 1980’den sonra kurumsallaşmıştır. CBS’nin gelişim aşamaları Tablo 4.1’de 

verilmiştir (Tecim, 2008a). 

Tablo 4.1. CBS’nin Dünyadaki ve Türkiye’deki Gelişim Aşamaları 

1970’ten Önce 1970’ler 1980’ler 1990’lar 2000 ve Sonrası 

1963’te Kanada’da 
URISA ve CBS 
(CGIS) kuruldu. 

1970’te CBS 
projesi 
tamamlandı. 
CBS’ye yönelik 
ilk sempozyum 
gerçekleşti. 

1981’de Arc/Info 
CBS yazılımı 
piyasaya sürüldü. 
GPS uygulamaya 
geçirildi. 

MapInfo Professional 
piyasada yerini aldı. 

CBS mobil hayata geçti. 
ArcPad piyasaya sürüldü. 

1969’da Integraph 
ve ESRI kuruldu. 

1972’de Landsat 
fırlatıldı. 

GRASS yazılımı 
1984’te  
geliştirildi. 

MapeXtreme, MapBasic 
ve ArcCAD piyasaya 
sürüldü. 

ArcGIS 8.1 2001’de 
piyasaya çıktı. 

 ERDAS 1978’de 
kuruldu. 

MapInfo kuruldu. 
İlk CBS kitabı 
Burrough tarafından 
yazıldı. 

1. Ulusal CBS 
Sempozyumu Türkiye’de 
KTÜ tarafından 
gerçekleştrildi. 

TÜBİTAK BILSAT 
2003’te fırlatıldı. 

  1987’de Idrisi 
hayata geçirildi.  

RADARSAT-SAR 
1995’te fırlatıldı. 

MapeXtreme.NETs ve 
ArcGIS 9 2004’te piyasaya 
sürüldü. 

  
Türkiye’de 1984’te 
EGHAS yazılımı 
geliştirildi.  

ArcGIS geliştirildi. 
ArcIMS ve Arc/Info 8 
geliştirildi. 

 

  
EMİ Mühendislik 
ve NETCAD 
kuruldu. 

  

Kaynak: (Tecim, 2008a) 
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4.1.3 CBS’nin Temel Bileşenleri 

CBS’nin yazılım, yöntem, veri, donanım ve kullanıcı bileşenleri bulunmaktadır. (Şekil 

4.2) 

 

Şekil 4.2. CBS’nin Bileşenleri 

Donanım: CBS’nin çalışmasını sağlayan bilgisayar ve bileşenlerinin tümüdür.  

Yazılım: Coğrafi verilerin işlenmesi amacıyla gerçekleştirilen algoritmaların tümüne 

denir.  

Yöntem: Sistemin çalışmasını sağlayan kurallar bütünüdür. 

İnsan: Sistemin tasarlayıcısı ve etkin kullanımını sağlayan kişidir. 

Veri: Çalışmada istenilen sonuca ulaşabilmek için gerekli bilgidir. Vektör veri, raster 

veri ve öznitelik verileri olmak üzere üçe ayrılır. 

 

 

 

CBS

Donanım

Yazılım

Veriİnsan

Yöntem
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Çizgi, nokta ve poligon özelliklerine sahip nesnelerin belirli bir koordinat sisteminde 

öznitelik bilgileriyle beraber dijital ortamda tutulduğu verilere “Vektör Veri” denir. Vektör 

veriler üçe ayrılır:  

1. Nokta vektör veri: Tek olguya ait verilerdir. Elektrik direklerine ait yerler, 

şehirdeki okullar, bankalar örnek olarak verilebilir. 

2. Çizgi vektör veri: Birden fazla noktanın birleşmesiyle elde verilerin 

gösterilmesidir. Telefon ve elektrik hatları, su şebekeleri, kanalizasyon şebekeleri, 

yollar, nehirler örnek olarak sıralanabilir. 

3. Poligon vektör veri: Belli bir noktadan başlayıp aynı noktada sona eren, genelde 

bir alan, bölge ifade eden verilerin gösterilmesidir. Elektrik dağıtımının yapılacağı 

bölge, ormanlar, göller gibi örnekler verilebilir. 

Vektör veriler Şekil 4.3’te gösterilmiştir. 

 

Şekil 4.3. Vektör Veri 

Kaynak: (Tecim, 2008b) 

Algılanan görüntülerin küçük parçalara ayrılarak “Grid” denilen hücreler halinde 

oluşturulmasını sağlayan verilere “Raster Veri” denir. Her hücre sadece bir değer alır. Uydu 

görüntüleri örnek olarak verilebilir.  Şekil 4.4’te raster veri yapı gösterilmiştir (Tecim, 

2008b). 
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Şekil 4.4. Raster Veri 

Kaynak: (Tecim, 2008b) 

Öznitelik verileri; mekânsal olmayan veri türüdür. Bir nesneye ait saklanmak, 

depolanmak istenen özelliklerin tümünü tablo veya metin olarak belirten veridir. Bir binanın 

yüksekliği, genişliği, cinsi, yapım yılı örnek olarak verilebilir. 
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4.1.4 CBS’nin Kullanıldığı Alanlar 

Teknolojik gelişmelerle birlikte veri sayısındaki çeşitlilik ve artan veri sayısı CBS’nin 

önemini artırmaktadır. CBS’nin kullanım alanlarından bazıları aşağıda gösterilmiştir; 

 Bayındırlık: İmar işlemleri, bina hasar tespiti, devlet denetiminde bulunan yolların 

etütleri, afet yönetimi, binaların cins dağılımı örnek olarak verilebilir. 

 Doğal Kaynak: Arazinin doğal yapısı, havza analizi, su kaynakları, yer altı ve yer 

üstü kaynak yönetimi, akarsular, petrol kaynakları, madenler örnek olarak 

sayılabilir. 

 Çevre: Çevre düzen ve koruma alanları, gölet, göl, Çevresel Etki Değerlendirmesi 

(ÇED), çevresel izleme, kirlilik yönetimi, hidroloji ve meteoroloji gibi örneklerdir. 

 İdari: Kadastro işlemleri, vergi işlemleri, nüfusu içinde barındıran çeşitli işlemler, 

idari sınırlar, tapuya ilişkin işlemler ve kent bilgi sistemleri sayılabilir. 

 Eğitim: Eğitim kurumlarının bölgesel dağılımı, planlama ve eğitim faaliyetlerine 

ilişkin diğer bazı işlemler sayılabilir. 

 Belediye: İmar ve buna ilişkin düzenlemeler, toplu taşıma, altyapı, belediye 

tesisleri ve yolları örnek olarak verilebilir. 

 Ulaşım: Hava, deniz, kara ulaşım ağları, enerji nakil hatları, iletişim istasyonları 

örnek olarak sıralanabilir. 

 Tarım ve Orman: Orman sınırları, milli parklar, arazi kullanımı gibi örnekler 

verilebilir. 

 Sağlık: Sağılık kurumlarının bölgesel dağılımı ve sağlığa ilişkin planlama ve 

düzenlemeler sayılabilir. 

 Güvenlik ve Savunma: Tatbikat alanları, askeri tesisler, emniyet, sivil savunma, 

suç haritaları gibi örnekler verilebilir. 

 Turizm: Turizm alanlarının bölgesel dağılımı ve turizme ilişkin düzenlemeler 

sayılabilir. 

 Sanayi ve Ticaret: Organize sanayi bölgeleri ve serbest bölgeler, pazarlama 

işlemleri örnek olarak verilebilir (Rüstemov, 2014). 
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4.1.5 CBS’nin Yararları 

Coğrafi Bilgi Sistemleri verileri kendine ait veri tabanında depolamanın yanı sıra veri 

güncellemesi, analiz, haritalama vb. işlemlerle kullanıcılara kolaylıklar sağlamaktadır. 

Bununla birlikte sağladığı yararlardan bazıları; 

 Bilgi aktarımının hızlanmasını sağlamaktadır. 

 Üretimde verimliliği artırmaktadır. 

 Analizlerin doğru ve etkili olmasını sağlamaktadır. 

 Verilerin güncellenmesini kolaylaştırmaktadır. 

 İş gücünü arttırmasının yanında zamandan tasarruf sağlanmasına etki etmektedir 

olarak sıralanabilmektedir (Töreyen, 2010). 

4.2 Uzaktan Algılama (UA) 

Uzaktan algılama teknikleri sayesinde kısa zamanda yeryüzündeki bir nesne veya 

mekân hakkında birçok veriye ulaşılmakta ve bu veriler haritalama, havza, iklim, arazi örtüsü, 

etüt vb. alanlarda kullanılmaktadır. 

Uzaktan algılama, bir nesne, mekân veya olay hakkında herhangi bir fiziksel temas 

olmaksızın çeşitli algılayıcı platformlarla veri toplayıp bilgi edinme teknolojisidir. Uzaktan 

algılama ile gözlemciden uzak bir noktada bulunan nesneler hakkında bilgi elde edilebilir. Bu 

amaç doğrultusunda kullanılan sensörler herhangi bir fiziksel temasta bulunmazlar. Uzaktan 

algılama sonucunda çıktılar genellikle sayısal görüntü biçimindedir.  

Yeryüzündeki nesneler özelliklerine göre (malzeme, yüzey pürüzlülüğü, ışın gelme 

açısı vb.) üzerine gelen elektromanyetik ışını farklı miktarda enerjiye dönüştürdükleri için 

kolaylıkla birbirinden ayırt edilmektedir. (Şekil 4.5) 

 

Şekil 4.5. Uzaktan Algılama 
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Uzaktan Algılama Aşamaları 

Uzaktan algılama işlemi temel olarak iki aşamadan oluşmaktadır. Bu aşamalar 

verilerin elde edilmesi ve verilerin işlenmesi aşamalarıdır. 

1. Verilerin Elde Edilmesi 

Kaynak: İlgili hedefe kaynak tarafından enerji gönderilir. Kaynak tarafından hedef ya 

aydınlatılır ya da hedefe elektromanyetik enerji gönderilir. Enerji kaynağı optik uydular için 

güneş iken radar uydular kaynağını üzerinde taşır ve elektromanyetik enerjiyi kendisi üretir. 

Atmosfer ve Işınım: Kaynaktan çıkan enerjinin atmosferde yol alırken maruz kaldığı 

etkileşimlerdir. 

Hedef Etkileşimi: Elektromanyetik dalgalar hedefe ulaşarak hem ışınım hem de 

hedefin özelliklerine bağlı olarak hedefle etkileşimde bulunurlar. 

Verinin Kaydedilmesi ve İşlenmesi: Hedeften alınan enerji ilgili algılayıcı tarafından 

kaydedilir ve veri işlenmek amacıyla uydu istasyonuna gönderilir. 

2. Verilerin İşlenmesi 

Analiz: Elde edilen veriler analiz edilir ve yorumlanır. Görüntüler sayısal, görsel ve 

elektronik işleme tekniğiyle zenginleştirilerek kullanıma hazır hale getirilir. 

Uygulama: İşlenmiş verilerden bilgi elde edilir ve birtakım sonuçlara ulaşılır. Veriler 

başka verilerle birleştirilerek kullanılabilir. 

Uzaktan algılamada görüntüleme işlemi iki farklı sistemle elde edilmektedir. Bu 

sistemler aktif ve pasif sistemlerdir. Aktif sistemler enerji kaynağını kendi üzerinde taşıyarak 

elektromanyetik dalga sinyalleri ile çalışırken pasif sistemler ise yeryüzünün doğal enerji 

kaynağı olan güneş enerjisini kullanırlar. Ses dalgalarının gönderilmesi esasına dayanan 

SONAR (Sound Navigation And Ranging), ışık (lazer) gönderilmesi esasına dayalı LIDAR 

(Light Detection And Ranging) ve radyo dalgalarına dayalı RADAR&SAR (Radio Detecting 

and Ranging, Synthetic Aperture Radar) aktif sistemlere örnek olarak verilebilir. Kızılötesi,  

pankromatik, multispektral, hiperspektral ise pasif alıcılara örnektir. 

Uzaktan algılama sonucunda elde edilen verilerde bazı işlemler yapılır. Bunlar 

radyometrik düzeltme (tarayıcının geometrisinden bağımsız, veride bulunan sistematik 

hatanın giderilmesi), geometrik düzeltme (elde edilen görüntünün bir harita veya bilgi tabanı 
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ile birleştirilmesiyle gerçek boyutunda düzeltme işlemi), görüntü zenginleştirme (filtreleme ve 

kontrast artırma gibi işlemlerle gözle yorumlamayı kolaylaştırma) ve sınıflandırma işlemidir.  

Sınıflandırma; yeryüzündeki nesnelerin yansıttığı veya yaydığı ışınım farkından 

yararlanarak pikselleri gruplandırma işlemidir. Kontrollü sınıflandırma ve kontrolsüz 

sınıflandırma olmak üzere ikiye ayrılır. Kontrolsüz sınıflandırma, kullanıcının sınırlı 

yönlendirmesi ve yazılım tarafından hesaplanan uydu görüntülerinin spektral yansımasına 

dayalı işlemdir. Kontrollü sınıflandırma, uzman kişi tarafından yönlendirilmiş sınıflandırma 

işlemidir. Araştırmacının çalışma alanı ile ilgili bilgilere sahip olması gerekir. 

Coğrafi Bilgi Sistemleri ve Uzaktan Algılama teknolojilerinden yararlanarak yapılan 

bazı çalışmalar şu şekildedir: 

Mohammedi ve ark. (2020), Kuzey İran'daki Talar havzasının taşkın riskini CBS’de 

değerlendirerek taşkın riski haritası oluşturmuşlardır. 

Uçar (2018), Ceyhan Havzası’nda yaptığı çalışmada hidrolojik modeller için akarsu 

havza parametrelerinin belirlenmesini CBS ve ArcGIS yazılımından yararlanarak belirlemeyi 

amaçlamıştır. 

Dağhan (2017), yaptığı çalışmada Seydisuyu havzasında küçük ölçekli hidroelektrik 

enerji potansiyelini CBS yardımıyla araştırmışlardır. 

Kılınç (2017), Gaziantep ilinin su ihtiyacını ve su tüketimini incelemiştir. İlin su 

ihtiyacının karşılanması amacıyla Göksu havzasını CBS ve yardımcı programlar (ArcGIS) ile 

araştırdığı görülmektedir. 
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5. ÇALIŞMA ALANI 

5.1 Genel Bilgiler ve Konum 

Doğu Anadolu Bölgesi’nde yer alan Malatya Yukarı Fırat Havzası’nın Malatya Ovası 

üzerine kurulmuştur. 35° 54' ve 39° 03' kuzey enlemleri, 38° 45' ve 39° 08' doğu boylamları 

arasındadır. (Şekil 5.1) Adıyaman, Kahramanmaraş, Elâzığ, Sivas, Diyarbakır ve Erzincan 

illerine komşudur. (Şekil 5.2) Yüzölçümü 12.313,00 km2 olup ortalama yükseltisi 964,00 

metredir.  

 

Şekil 5.1. Malatya İli Konum Haritası  

Kaynak: (Coğrafyaharita, 2021) 

 

Şekil 5.2. Malatya İlçeler ve Komşu İller Haritası 

Kaynak: (Coğrafyaharita, 2021) 
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Çalışma alanının koordinatları Tablo 5.1’de gösterilmiştir. 

Tablo 5.1. Çalışma Alanının Koordinatları 

Nokta Enlem Boylam 

1 38°33'59.09"K 37°46'20.44"D 

2 38°32'59.42"K 38°38'14.89"D 

3 38°6'7.17"K 38°42'23.33"D 

4 38°5'29.22"K 37°44'54.59"D 

 

Şehir merkezi az eğimli düz bir alana kurulmuştur. Şehrin güneyine Beydağlarına 

doğru artan eğim ulaşımı zorlaştırsa da şehir merkezi içinde doğu-batı yönlü uzanan caddeler 

ulaşımı kolaylaştırmıştır. Şehre ait bu özellikler bazı sorunlara neden olmaktadır. Özellikle 

ilkbaharda kar erimeleri ile beraber yağışın artması şehir merkezinde su baskınlarına sebep 

olmaktadır. 

Bu çalışmada taşkın risk haritasının oluşturulması şehirdeki sağlık, konut, sanayi, 

eğitim, resmi kurum, sosyal tesis gibi alanların risk grubunda olup olmadığı, risk grubunda ise 

buna bağlı olarak yeni planlamaların yapılması ve gerekli tedbirlerin alınması açısından 

büyük önem taşımaktadır. Şehirleşme büyük ölçüde merkez Battalgazi ve Yeşilyurt 

ilçelerinde toplandığından çalışma alanı olarak merkez ilçeler seçilmiştir. Çalışma alanı Şekil 

5.3’teki gibidir. 
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Şekil 5.3. Çalışma Alanı 

5.2 İklim 

Malatya, karasal iklim ile Akdeniz ılıman iklimi arasında bir geçiş iklimine sahiptir. 

Kışları karasal iklimden soğuk, kuru; yazları Güneydoğu’dan aldığı sıcak, kuru; ilkbaharda ise 

Akdeniz bölgesinden aldığı ılık ve nemli iklim özelliklerini görmek mümkündür. Meteoroloji 

Genel Müdürlüğü’nden elde edilen Malatya iline ait sıcaklık verileri Tablo 5.2’de 

belirtilmiştir (MGM, 2021b). 
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Tablo 5.2. Malatya 1960-2020 Ortalama Sıcaklık 

Aylar Ort. Sıcaklık (°C) 
Ort. En Yüksek 

Sıcaklık (°C) 

Ort. En Düşük 

Sıcaklık (°C) 

Ocak 0,24 3.28 -2.42 

Şubat 2,83 5.41 -0.31 

Mart 2,83 9.98 4.60 

Nisan 2,83 21.89 10.36 

Mayıs 18.17 30.74 14.83 

Haziran 23.75 40.32 19.73 

Temmuz 28.06 48.53 23.10 

Ağustos 28.11 48.19 22.51 

Eylül 23.06 38.53 17.68 

Ekim 15.78 25.43 11.75 

Kasım 7.67 10.21 5.10 

Aralık 2.16 5.03 0.17 

Yıllık 14.22 23.96 10.59 
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Grafik 5.1. Malatya İli Aylık Ortalama Sıcaklık Dağılımı 

1960-2020 yılları arasında Meteoroloji Genel Müdürlüğü tarafından ölçülen değerlere 

göre Malatya ilinin yıllık ortalama sıcaklık değeri 14,22 ℃’dir. Tabloya göre yıllık ortalama 

en yüksek sıcaklık değeri 23,96 ℃ iken ortalama en düşük sıcaklık değeri ise 10,59 ℃ olarak 

ölçülmüştür. Malatya’da en soğuk ve en sıcak aylar sırasıyla Ocak ve Temmuz olup aylık 

sıcaklık ortalamaları arasındaki fark yüksektir. (Grafik 5.1) 

Malatya’da yağış en çok ilkbaharda görülürken, yağışın en az olduğu mevsim yazdır. 

Malatya’da 2009-2020 yılları arasında ölçülen aylık toplam yağış miktarı ortalamaları Tablo 

5.3’te gösterilmiştir (MGM, 2021c). 

Tablo 5.3. Malatya 2009-2020 Aylık Yağış Miktarı 

 

Malatya 

Aylar  

Yıllık O Ş M N M H T A E E K A 

Aylık Ortalama 
Yağış 

Miktarı (mm) 
48.26 35.82 48.55 42.17 48.58 16.21 5.84 4.41 10.67 28.07 31.25 43.84 363.67 

Aylık 
Maksimum 

Yağış 
Miktarı (mm) 

92.60 63.28 81.94 69.23 139.39 42.39 31.86 18.49 18.72 39.07 57.96 86.34 741.25 

Aylık 
Minimum 

Yağış 
Miktarı (mm) 

24.00 17.80 31.45 21.83 30.48 6.25 0.84 0.80 4.36 18.22 22.44 24.17 202.62 
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Grafik 5.2. 2009-2020 Aylık Toplam Yağış Miktarı Ortalaması 

Meteoroloji Genel Müdürlüğü tarafından 2009-2020 yılları arasında ölçülen değerlere 

göre aylık toplam yağış miktarı ortalaması 363,67 mm’dir. Tabloda görüldüğü gibi en çok 

yağış 48,58 mm olarak Mayıs’ta düşerken en az 4,41 mm yağış ise Ağustos’ta düşmüştür. 

Grafik 5.2’de görüldüğü gibi en düşük yağış miktarı yaz aylarında iken en fazla yağış miktarı 

ilkbahar aylarında düşmektedir. Yağışların %38,3’ü ilkbahar, %35,2’si kış, %19,2’si sonbahar 

ve %7,3’ü ise yaz aylarında düşmektedir. 

Malatya karasal iklim kuşağında yer aldığından genel bitki örtüsü bozkırdır. Daha çok 

otsu ve dikensi küçük çalılar bitki örtüsünü oluşturmaktadır. İlkbahar aylarında yeşil olan bu 

topluluklar yaz gelince sararıp kurur. Malatya’daki bozkırlar antropojen özelliktedir. Daha 

önce yoğun bir orman örtüsüne sahip iken beşeri faaliyetler soncunda tahrip edilmiştir. Yani 

genel olarak bitki örtüsünden yoksundur. Fakat Pütürge ve Doğanşehir ilçeleri bitki örtüsü 

bakımından diğer yerlere göre daha zengindir. Daha çok meyvecilik için dikilen kayısı 

ağaçları il genelinde büyük alan kaplarken meşe ve kızılçam ağaçlarına da rastlanmaktadır. 
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5.3 Hidrografya 

Fırat Havzası’nda yer alan Malatya akarsular bakımından zengindir. Fırat’ın önemli 

kollarından biri olan Tohma Çayı ve bu çayın kolları tarafından sulanmakta olan Malatya, su 

sıkıntısı çekmeyen kentlerden biridir.  

Tohma Çayı  

Sivas il sınırlarından doğup Malatya il sınırlarından Karakaya baraj gölüne dökülen 

Tohma Çayı, 52 km uzunluğuyla şehrin en önemli çayıdır. Dört mevsim bol miktarda su 

bulunur. Hacılar Tohması ve Yukarı Tohma en önemli kollarıdır. 

Sultansuyu  

Tohma Çayı’nın önemli bir kolu olup üzerinde sulama amaçlı inşa edilen Sultansuyu 

Barajı bulunmaktadır. 

Beylerderesi  

Pınarbaşı, Beydağları’ndan başlayarak Derme Suyu başta olmak üzere birçok kola 

ayrılır. Yeşilyurt ilçesinden Battalgazi ilçesine doğru akar. Oluşturduğu kollar ile birlikte 

bölgenin büyük bir kısmının sulama ihtiyacını karşılamaktadır (ÇED Raporu, 2019). 

Diğer önemli suları; Kuruçay, Melet Deresi, Horata Suyu, Elemendik Suyu, Orduzu 

(Pınarbaşı) Suyu ve Şiro Çayı’dır. 

Malatya’da doğal göller fazla yer almamakta olup küçük göller bulunmaktadır. Bunun 

dışında sulama amaçlı yer alan baraj ve baraj gölleri; Sultansuyu Barajı, Karakaya Baraj Gölü, 

Recai Kutan (Boztepe) Barajı, Çat Barajı Gölü, Sürgü Barajı Gölü, Turgut Özal (Kapıkaya) 

Barajı, Medik Barajı Gölü, Polat Barajı Gölü, Hekimhan Güzelyurt Göleti, Sofular Göleti, 

Arapgir Göleti olarak sıralanabilir. 

Yer üstü su kaynakları bakımından zengin olan Malatya’nın yer altı su kaynaklarını da 

Şehir Deresi, Aydoğan Deresi, Beylerderesi ve Orduzu Deresi olarak sıralamak mümkündür 

(Engin, 2015a). 

Çalışma alanında yer alan akarsular; Fırat Nehri, Tohma Suyu, Beylerderesi, Horata 

Çayı, Orduzu Çayı’dır. Barajlar; Kapıkaya ve Beylerderesi, göletler; Orduzu Göleti, Kaldırım 

Göleti, Maryap Göleti’dir. 
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5.4 Jeomorfolojik Özellikleri ve Toprak Yapısı 

Malatya yeryüzü şekilleri bakımından engebeli bir özellik taşımaktadır. Malatya ilinin 

ana yer şekilleri dağlar, platolar ve ovalardan oluşmaktadır. Platolar fazla yer kaplarken 

ovalara pek az rastlanmaktadır.  

Malatya ilinin güneyi Güneydoğu Toroslar’ın uzantısı olan Malatya Dağları ile doğu 

batı şeklinde sıralanmıştır. Batıda Nurhak dağları, kuzeyde Sivas ile sınırını oluşturan Yama 

Dağı yer almaktadır.  

Malatya’da toprakların büyük bir bölümünü kahverengi topraklar oluşturmakla 

beraber yer yer alüvyal topraklar, kırmızımsı ve kireçsiz topraklar da görülmektedir (Engin, 

2015b). 

Tarım ve Orman Bakanlığı CORINE (Çevresel Verilerin Koordinasyonu Projesi) 2018 

Malatya İli Bölgesel Raporu’na göre şehrin yüzölçümünün %0,95’i yapay alanlar, %35,81’i 

tarımsal alanlar, %61,79’u orman-yarı doğal alan, %0,02’si sulak alan, %1,43’ü su 

kütlelerinden oluşturmaktadır (TOB, 2021). (Grafik 5.3) 

 

Grafik 5.3. Malatya İli 2018 Arazi Kullanım Dağılımı  

Kaynak: (TOB, 2021) 
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5.5 Nüfus ve Yerleşme Özellikleri 

Malatya ilinde nüfus, Cumhuriyet Dönemi’nden sonra şeker, sigara ve dokuma 

fabrikalarının açılmasıyla artmaya başlamıştır. Şehrin 1990 yılından itibaren nüfus gelişimi 

Grafik 5.4’te verilmiştir (TÜİK, 2022). 

 

Grafik 5.4. Malatya 1990-2021 Nüfus Değişimi 

Grafik 5.4’te görüldüğü gibi 1990 ile 2000 yılları arasında nüfus miktarında önemli bir 

artış meydana gelmiştir. 1985 ile 1996 yılları arasında Çat Barajı’nın inşa edilmesi, Turgut 

Özal döneminde yapılan yatırımlar, sanayileşme ve şehirleşmenin beraberinde getirdiği 

değişimler ve tarım alanında özellikle kayısının değerlenmesi ile beraber Malatya’ya göç 

artmıştır ve nüfus 2000 yılına gelindiğinde önemli bir artış göstererek 853.658 kişi olmuştur. 

2007’de Adrese Dayalı Nüfus Kayıt Sistemi (ADNKS )’nin gelmesiyle beraber nüfus 

sayımlarında düzenlemeler yapılmıştır. 2008 yılından sonra ise nüfusun artırılmasına yönelik 

yapılan politikalarla beraber şehirleşme, sanayi, komşu ülkelerden savaş sebebiyle yapılan 

göçler ve eğitim amaçlı göçler nüfusu sürekli artırmış ve 2021 yılında yapılan son sayımla 

Malatya nüfusu toplam 808.692 olmuştur. 
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5.6 Malatya’da Yakın Tarihte Meydana Gelen Bazı Taşkınlar 

Malatya’nın Yeşilyurt ilçesinde 03.03.2022 tarihinde kar erimeleri sonucunda bölgede 

küçük çapta bir taşkın görülmüştür (Posta, 2022). 

 

Şekil 5.4 Malatya’da Taşkın  
Kaynak: (Posta, 2022) 

 

Şekil 5.5. Malatya’da Taşkın 

Kaynak: (İlkha, 2022) 
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Malatya’da çalışma bölgesinde kalan çevreyolu üzerinde 10.08.2021’de günlerce 

devam eden sağanak yağışlar nedeniyle yer yer caddeler altyapı yetersizliğinden dolayı sular 

altında kalarak trafiği olumsuz etkilemiştir (Sabah, 2021). (Şekil 5.6) 

 

Şekil 5.6. Çevreyolu Taşkını  
Kaynak: (Sabah, 2021) 
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Malatya’nın içme suyunu sağlayan ve çalışma bölgesi içinde yer alan Gündüzbey’deki 

kaptaj tesisinde 23.07.2021’de meydana gelen taşkın dolayısıyla can kaybı olmaksızın çevre 

zarar görmüştür.(Şekil 5.7) Bir süre içme suyu vanaları kapatılarak tedbir alınmıştır (Malatya 

Net Haber, 2021). 

 

Şekil 5.7. Gündüzbey Kaptaj Tesisi Taşkını 
Kaynak: (Malatya Net Haber, 2021) 
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6. VERİ VE YÖNTEM 

6.1. Veri 

6.1.1. Kriterlerin Belirlenmesi 

Taşkına neden olan faktörlerin belirlenmesi taşkın riskinin değerlendirilmesi açısından 

son derece önemlidir. Kullanılan faktörlerin çokluğu, kalitesi ve problemi tam olarak 

karakterize etmesi önem taşımaktadır. Bu nedenle yapılan çalışmada literatür araştırmaları, 

çalışma alanına ait özellikler ve elde edilen veriler dikkate alınarak kriterler belirlenip 

problem çözülmeye çalışılmıştır. 

Bu çalışmada yağış, sıcaklık, eğim, akarsulara uzaklık ve arazi kullanımı kriterleri 

kullanılmıştır. 

6.1.2. Çalışma Alanının Koordinatlandırılması ve Görüntü Düzeltme 

Çalışma alanına ait koordinatlar Google Earth yazılımı kullanılarak belirlendi. 

İşaretlenen koordinatların oluşturduğu alan seçilerek çalışma alanına ait uydu görüntüsü elde 

edilmiştir. 

Uydu görüntüleri olduğu gibi harita olarak kullanılamazlar. Bunun nedeni sistematik 

veya sistematik olmayan bozulmalardır. Bunlar yükseklik, konum veya algılayıcı 

platformunun hızındaki değişimler, yeryüzünün eğriliği veya atmosferik kırılma gibi 

nedenlerdir. Bu gibi nedenlerle oluşan bozulmaların düzeltilmesi kullanımı kolaylaştıracaktır. 

Görüntü düzenleme işlemi UTM (Universal Transverse Mercator) harita projeksiyon 

sistemine uygun 37. Kuzey Zone D_European_1950 Datum sistemi ile uygun olarak 

koordinatlandırılmıştır. Daha sonra Windows→Image Analysis→Select Features→Clip 

işlemi ile çalışma alanının sınırları belirlenmiştir. Düzeltme işlemi Şekil 6.1’de verilmiştir. 
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Şekil 6.1. Çalışma Alanı Görüntü Düzeltme 

6.1.3. Sayısal Yükseklik Modeli (SYM) 

Coğrafi Bilgi Sistemleri teknolojilerinde kullanılan Sayısal Yükseklik Modeli (SYM) 

olarak adlandırılan Digital Elevation Model (DEM), herhangi bir araziye ait yükseklik 

verilerinden yararlanarak arazinin 3B olarak modellenmesidir. Araziye ait bakı, havza alanı ve 

eğim gibi özellikler bu model ile belirlenebilmektedir. Bu çalışmada SYM’den yararlanarak 

eğim haritası elde edilmiştir. 

Sayısal Yükseklik Modeli U.S. Geological Survey Earth Explorer’dan indirilip 

ArcMap yazılımına aktarılarak gerekli düzenlemelerden sonra Şekil 6.2’deki gibi son halini 

almıştır. 
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Şekil 6.2. SYM 

Çalışma alanının yükseltisine bakıldığında bölgenin yükseltisinin fazla olduğu 

görülmektedir. Yükselti kuzeyden güneye gittikçe artmaktadır. Çalışma alanında en düşük kot 

666 m iken en yüksek kot 2559 m olarak belirlenmiştir. 

6.1.4. Eğim 

Taşkın oluşmasında eğim faktörü önemli bir etkiye sahiptir. Eğim, sızma ve 

buharlaşma miktarına etki eder. Eğim çok olursa toprağın suyu tutma kapasitesi 

azalacağından buharlaşma ve sızma az olur. Eğimin fazla olduğu alanlarda akışa geçen su 

miktarı daha fazla olur. Buradan akışa geçen su, eğimin düşük olduğu mansap bölgelerinde 

taşkın oluşturma riskini arttırır. Bu nedenle eğimin düşük olduğu yerler taşkınların yaşanma 

riskinin fazla olduğu yerler olarak analizlerde önem derecesi yüksek olarak atanmıştır 

(Hoşgören, 2001; akt. Sunkar, 2018). 

Eğim haritası, çalışma alanına ait DEM verilerinin ArcGIS 10.2 yazılımına 

yüklendikten sonra “Spatial Analyst Tools→ Surface→ Slope” işleminin yapılmasıyla elde 

edilmiştir. Çalışma alanının eğim haritası “Reclassify” aracı kullanılarak beş sınıfa ayrılmıştır. 

Eğim derecesine göre 0°-5°, 5°-10°, 10°-15°, 15°-20°, 20°-61,91° olarak sınıflandırılmıştır. 

Çalışma bölgesinde 5°-10° ve 0°-5° eğime sahip alanlar yoğunlukta iken çok eğimli araziler 

üçüncü sırada yer almaktadır.  
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Çalışma alanının eğim verileri gösteriyor ki taşkına duyarlı alanlar yoğunluktadır. 

Çalışma alanına ait ağırlık değerleri ve sınıflandırılmış eğim dereceleri Tablo 6.1’de 

gösterilmiştir. 

Tablo 6.1. Sınıflandırılmış Eğim ve Ağırlık Değerleri 

Eğim (Derece) Morfolojik Tanımı Alan (km²) Ağırlık Değeri Etki Düzeyi (%) 

0°-5° Çok Az Eğimli 436,0607613 5 

10 

5°-10° Az Eğimli 444,7203006 4 

10°-15° Hafif Eğimli 280,6828849 3 

15°-20° Dik Eğimli 211,712746 2 

20°-61,91° Çok Dik 374,8149193 1 

 

Eğim haritası Şekil 6.3’te verilmiştir. 

 

Şekil 6.3. Eğim Haritası 
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Haritaya göre yeşil ve sarı renkler az eğimli yerleri ifade ederken turuncu ve kırmızı 

renkler ise yüksek eğimli alanları ifade etmektedir. Eğim haritasına göre çalışma alanının 

büyük bir kısmı az eğimli bir yapıya sahiptir. Buna göre çalışma alanı taşkına duyarlı bir 

yapıdadır. Eğimin düşük olduğu bölgeler taşkınların meydana geldiği sahalardır. Taşkın suları 

yukarıdan (membadan) yüksek hızlarda gelerek az eğimli ovalarda yayılırlar. Bu nedenle az 

eğimli bölgeler taşkınların yaşandığı sahalardır. Bu nedenle düşük eğim sınıfına yüksek 

ağırlık değeri atanmıştır. Çok az eğimli yerlere ağırlık değeri olarak 5, az eğimli yerler 4, hafif 

eğimli yerler 3, dik eğimli yerler 2 ve çok dik eğimli yerlere ise 1 değeri atanmıştır. Etki 

yüzdesi 10 olarak belirlenmiştir. 

6.1.5. Arazi Kullanımı 

Kaçak yapılaşma sonucunda insanlar tarım arazilerini, yeşil alanları, su havzalarını ve 

diğer canlıların hayatını olumsuz etkilemiştir. Kaçak yapılaşma ve düzensiz planlama 

sonucunda altyapı sorunları da ortaya çıkmıştır. Geçirimsiz yüzeylerde suyun akışa geçmesi 

taşkınlara sebep olmaktadır (Çokoyoğlu, 2008).  

Arazi kullanımında veriler taşkına sebep olan etkileri dikkate alınarak su, şehir ve 

yapay yüzeyler, yeşil alanlar ve çıplak arazi olmak üzere dört sınıfa ayrılmıştır. Çalışma 

alanına ait uydu görüntüsünün üzerinde arazinin sınıflandırma işlemini yapabilmek için 

“Draw Polygon” komutu ile sınıflandırma yapmak istenilen yüzeylere ait poligon çizimleri 

yapılmıştır. Poligon çizimleri tamamlanınca “Classification→Maximum Likelihood 

Classification” ile arazi sınıflandırma işlemi yapılmıştır. Daha sonra “Spatial Analyst 

Tolls→Reclass→Reclassify” yeniden sınıflandırma işlemi ile çakıştırmada kullanılacak harita 

elde edilmiştir. Arazi kullanımına ait harita Şekil 6.4’te gösterilmiştir. 
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Şekil 6.4. Arazi Kullanım Haritası 

Tablo 6.2. Sınıflandırılmış Arazi Kullanımı ve Ağırlık Değerleri 

Arazi Sınıfı Alan (km2) Ağırlık Değeri Etki Düzeyi (%) 

Su 44,93954736 1 

20 
Çıplak Arazi 1203,599853 4 

Yeşil Alan 102,8710942 2 

Şehir ve Yapay Yüzey 396,7104523 5 

 

Tablo 6.2’ye bakıldığında yerleşim bölgesinin daha yoğun olduğu görülmektedir. Bu 

durum taşkın etkisinin kentleşmenin yoğun olduğu bölgelerde ne derece öneme sahip 

olduğunu göstermektedir. Kentsel ve endüstriyel alanlar (yollar, binalar, asfaltlar) su tutan, 

emilimi azaltan ve akışı hızlandıran alanlardır. Bu nedenle önem derecesi 5 olarak 

belirlenmiştir. Yerleşim bölgesinin dışında ise genel olarak çıplak arazi yoğunluktadır. Çıplak 

arazinin varlığı suyun akışını hızlandıracağından taşkın riski yüksek olup önem derecesi 4 

olarak belirlenmiştir. Ormanlık alanlar veya yoğun bitki örtüsü alanları, toprağın suyu emme 

ve akışı azaltma kabiliyeti nedeniyle taşkına karşı daha az hassastır. Bu nedenle önem 

derecesi 2 olarak belirlenmiştir. Bölgede su varlığı ise küçük bir yoğunluğa sahiptir ve önem 

derecesi 1 olarak belirlenmiştir. Etki yüzdesi 20 olarak belirlenmiştir. 
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6.1.6. Sıcaklık 

Çalışmada kullanılan veriler Meteoroloji Genel Müdürlüğü’nden elde edilmiştir. Bu 

çalışmada aylık ortalama sıcaklık değerleri kullanılmıştır. İstasyonlara ait ölçümler 1960-2020 

yılları arasını kapsamaktadır. Çalışma alanına ait istasyonlar ve bu istasyonlara ait veriler 

Tablo 6.3’te belirtilmiştir (MGM, 2021d). 

Tablo 6.3. 1960-2020 İstasyonlara Göre Sıcaklık Verileri 

İst. No- İst. Adı 

Aylar 

O Ş M N M H T A E E K A 

17706-Akçadağ 1,20 3,52 8,15 12,98 17,79 23,40 27,28 27,04 22,01 14,73 7,48 2,51 

17764-Arapgir -1,61 -0,31 4,60 10,52 15,72 20,82 24,93 25,15 20,90 14,15 6,66 0,95 

18189-Arguvan 0,08 3,16 7,54 11,96 16,81 22,55 26,81 27,28 22,54 15,78 7,71 1,98 

18187-Battalgazi/Meyvecilik 
Arş. (TAGEM) 1,53 4,18 8,89 13,18 18,31 23,00 27,48 27,15 21,65 14,98 7,20 2,80 

18185-Darende -0,41 2,88 7,50 12,05 16,74 21,66 25,68 25,85 21,45 14,69 6,61 1,32 

17842-Darande/Balaban -2,42 0,34 9,98 21,89 30,74 40,32 48,53 48,19 38,53 25,43 10,21 0,54 

17872-Doğanşehir -1,96 -0,26 4,93 10,43 14,83 19,85 23,10 22,51 17,68 11,75 5,10 0,17 

18352-Doğanyol 2,63 5,41 9,77 13,83 18,83 24,80 29,30 29,30 24,81 17,28 9,59 4,36 

18183-Hekimhan -0,71 2,36 6,81 11,35 16,04 21,28 25,38 25,88 21,25 14,10 6,79 1,39 

18184-Kuluncak -1,90 1,19 5,89 10,36 15,50 19,73 23,50 24,04 19,24 13,09 5,40 0,47 

17199-Malatya 0,27 1,99 7,17 13,00 17,93 23,14 27,23 27,06 22,57 15,65 7,86 2,40 

17845-Malatya/Kale 3,28 5,34 9,81 14,64 19,50 25,09 28,96 28,86 23,83 17,18 9,64 5,03 

18353-Malatya/Kayısı Arş. 
Ens. 0,97 3,91 8,73 12,94 17,74 22,91 26,81 26,93 22,64 14,65 7,24 2,51 

18186-Pütürge 0,64 3,58 7,70 12,01 16,86 22,44 26,60 27,00 22,49 16,07 8,30 2,58 

18188-Yazıhan 1,95 5,14 9,63 14,14 19,25 25,23 29,28 29,39 24,26 17,19 9,33 3,46 

Malatya İli Ort. Ortalaması 0,24 2,83 7,81 13,02 18,17 23,75 28,06 28,11 23,06 15,78 7,67 2,16 
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Grafik 6.1. 1960-2020 Ortalama Sıcaklık Dağılımı 

Tablo incelendiğinde en yüksek sıcaklık değeri 28,11°C olarak Ağustos’ta görülürken 

sıcaklığın en düşük değeri 0,24°C ile Ocak’ta görülmüştür. Malatya ilinde en sıcak aylar 

Haziran, Temmuz ve Ağustos iken en soğuk aylar Aralık, Ocak ve Şubat olarak belirlenmiştir. 

(Grafik 6.1) 

İklim değişikliğiyle beraber sıcaklıklarda meydana gelen düzensizlikler taşkınların 

oluşumunda önemli bir rol oynamaktadır. Sıcaklıkların normalin üzerinde seyretmesi, 

özellikle ilkbahar aylarındaki ani kar erimeleri taşkınların oluşumunu etkilemektedir. Ayrıca 

şehirleşmenin yoğun olduğu alanlarda yapay yüzeylerin etkisiyle sıcaklıklar artmakta ve 

buharlaşma oranı azalmaktadır. Buna karşın doğal ortamlarda (orman ve tarım arazileri gibi) 

sıcaklık ortalamaları daha düşük ve buharlaşma oranı daha yüksektir.  

Çalışmada kullanılacak istasyonlara ait koordinat bilgileri ArcGIS ortamına 

“File→Add Data→Add XY Data” adımları izlenerek aktarılır. Excell ortamından aktarılan 

veriler nokta veri tabanına “İstasyon Layer →Data→Export Data” işlemleri ile çevrilir. Daha 

sonra “New Personal Geodatabase” üzerinden sıcaklık verileri düzenlenir. 

Sıcaklık dağılım haritası oluşturulurken izlenen adımlar şu şekildedir: “Geostatistical 

Analyst→ Geostatistical Wizard→ Data Field Sicaklik→ Next→ Neighborhood Type 

Smooth→ Smoothing Factor 0.7→ Next→ Finish”. Oluşan geniş çaplı harita “Layer 

Properties→ Extent” komutu ile küçültülür. Daha sonra raster formatına “Data→ Export 

Raster Data” komutu ile çevrilir. Haritanın çalışma sınırlarına küçültülmesi için “Data 
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Management Tools→ Raster→ Raster Processing→ Clip” işlemleri yapılır. Oluşan harita 

“Layer Properties→ Symbology→ Classified” ile 5 sınıfa ayrılır ve renklendirme işlemi 

yapılır. Daha sonra “Spatial Analyst Tools→ Reclass→ Reclassify→ Input Raster Sicaklik” 

(Value ile her sınıf için yeni bir tam sayı değeri) ile yeniden sınıflandırma işlemi yapılarak 

analiz için harita son haline getirilmiş olur. Oluşturulan sıcaklık dağılım haritası ve 

sınıflandırılmış sıcaklık değerleri sırasıyla Şekil 6.5 ve Tablo 6.4’te belirtilmiştir. 

 

Şekil 6.5. Sıcaklık Haritası 

Tablo 6.4. Sınıflandırılmış Sıcaklık ve Ağırlık Değerleri 

Sıcaklık (°C) Alan (km2) Ağırlık Değeri Etki Düzeyi (%) 

12,62-13 12,4443 5 

5 

13-13,5 73,9173 4 

13,5-14 525,2811 3 

14-14,5 765,0829 2 

14,5-15,57 371,359 1 
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Bu çalışmada sıcaklık dağılım haritası Inverse Distance Weighting (IDW-Uzaklığın 

Tersi ile Ağırlıklandırma) yöntemi ile elde edilmiştir. IDW ile değerleri belli olan noktalar 

kümesinin ağırlıklı ortalaması sayesinde bilinmeyen noktaların değerleri tahmin edilir 

(Bayazıt, 2021b). Tablo 6.4’te görüldüğü gibi düşük sıcaklık değerine sahip alanlar için 

yüksek değer atanmış olup sıcaklık değerleri arttıkça atanan değerler düşmüştür. Buna göre en 

düşük sıcaklığa sahip alanlar için atanan değer 5 iken en yüksek sıcaklığa sahip alanlar için 

atanan değer 1’dir. Etki yüzdesi 5 olarak belirlenmiştir. 

6.1.7. Yağış 

Taşkın hesaplamalarında kullanılan yağış verileri Devlet Su İşleri ve Meteoroloji 

Genel Müdürlüğü tarafından yapılan istasyonlardan elde edilmektedir. Bu çalışmada 

MGM’den alınan 15 istasyona ait yıllık yağış verileri kullanılmıştır. İstasyonlara ait ölçümler 

2009-2020 yılları arasını kapsamaktadır. Bu çalışmada kullanılan verilere ait istasyonlar ve bu 

istasyonlara ait yağış verileri Şekil 6.6 ve Tablo 6.5’te verilmiştir (MGM, 2021e). 

 

Şekil 6.6. İstasyonlar 

 

 



48 
 

Tablo 6.5. 2009-2020 İstasyonlara Göre Yağış Verileri 

İstasyon No-İstasyon 
Adı 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 

17706-Akçadağ  265,00 348,40 423,80 289,00 433,80 368,10 302,40 252,60 421,00 378,20 410,20 

17764-Arapgir 145,80 420,20 794,00 667,40 183,20 548,90 483,60 504,20 459,80 622,60 654,20 657,20 

18189-Arguvan    158,60 199,90 203,20 387,70 378,10 256,00 342,70 173,90 206,80 

18187-
Battalgazi/Meyvecilik 
Arş.(TAGEM)    110,60 172,10 306,70 354,60 262,60 165,70 390,60 293,40 330,10 

18185-Darende    77,70 82,90 142,70 335,80 272,60 262,50 343,80 250,80 285,50 

17842-
Darande/Balaban 25,00 277,20 339,60 253,80 244,40 316,20 304,70 242,20 239,00 430,60 245,30 165,30 

17872-Doğanşehir 230,00 398,80 475,40 519,20 389,00 509,20 456,70 356,60 369,00 582,20 453,40 565,40 

18352-Doğanyol     23,50 419,90 50,60 491,40 295,10 655,30 653,00 559,60 

18183-Hekimhan    167,70 281,30 357,00 394,90 368,90 263,60 412,60 335,80 307,80 

18184-Kuluncak    85,90 131,30 300,20 343,30 226,70 244,20 365,90 249,50 298,50 

17199-Malatya 0,00 234,40 255,00 300,60 301,60 315,60 439,60 294,70 256,40 472,10 362,70 381,90 

17845-Malatya/Kale 136,80 264,20 999,40 480,00 75,80 245,10 236,20 246,40 260,80 395,40 319,20 179,40 

18353-Malatya/Kayısı 
Arş.Ens.     2,90 1460,50 515,60 470,40 244,70 223,20 184,50 190,40 

18186-Pütürge    143,10 420,10 586,50 567,80 498,40 326,50 665,90 613,10 539,80 

18188-Yazıhan    58,70 0,00 163,50 330,80 202,40 192,80 347,00 306,90 326,20 

Malatya İli Toplam 
Yağış 107,52 309,97 535,30 265,16 186,47 420,60 371,33 341,20 272,58 444,73 364,93 360,27 

 

 

Grafik 6.2. 2009-2020 Ortalama Yağış Miktarı 
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Grafik 6.2’ye göre Malatya ilinde 2009-2020 yılları arasında yapılan ölçümlerde yıllık 

ortalama yağış miktarı yıllara göre değişkenlik göstermekte olup en fazla yağış 2011 yılında 

535,30 mm iken en az yağış 107,52 mm ile 2009 yılına aittir. Son yıllarda ise yağış miktarı 

düşüş göstermiştir ve 2020 yılında yapılan ölçümlerde yıllık düşen yağış miktarı ortalama 

360,27 mm olarak ölçülmüştür. 

Bu çalışmada yağış dağılım haritası Inverse Distance Weighting (IDW-Uzaklığın 

Tersi ile Ağırlıklandırma) yöntemi ile elde edilmiştir. İstasyonlara ait yağış verileri 

düzenlendikten sonra yağış dağılım haritası oluşturulurken şu adımlar izlenir: “Geostatistical 

Analyst→ Geostatistical Wizard→ Data Field Yagis→ Next→ Neighborhood Type 

Smooth→ Smoothing Factor 0.7→ Next→ Finish”. Oluşan geniş çaplı harita “Layer 

Properties→ Extent” komutu ile küçültülür. Daha sonra raster formatına “Data→ Export 

Raster Data” komutu ile çevrilir. Haritanın çalışma sınırlarına küçültülmesi için “Data 

Management Tools→ Raster→ Raster Processing→ Clip” işlemleri yapılır. Oluşan harita 

“Layer Properties→ Symbology→ Classified” ile 5 sınıfa ayrılır ve renklendirme işlemi 

yapılır. Daha sonra “Spatial Analyst Tools→ Reclass→ Reclassify→ Input Raster Yagis” ile 

yeniden sınıflandırma işlemi yapılarak yağış dağılım haritası oluşturulur. Oluşturulan yağış 

dağılım haritası Şekil 6.7’de verilmiştir. 

 

Şekil 6.7. Yağış Haritası 
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Sınıflandırılmış yağış verileri ve ağırlık değerleri Tablo 6.6’da gösterilmiştir. 

Tablo 6.6. Sınıflandırılmış Yağış ve Ağırlık Değerleri 

Yağış (mm) Alan (km2) Ağırlık Değeri Etki Düzeyi (%) 

265,16-300 224,7271 1 

25 

300-325 290,954 2 

325-350 483,1217 3 

350-375 642,2311 4 

375-411,53 107,0507 5 

 

Taşkın analizlerinde en önemli verilerden biri yağıştır. Yağış miktarı arttıkça taşkın 

riski artacağından analizlerde atanan ağırlık değeri yüksektir. Tablo 6.7’de görüldüğü gibi 

yağış miktarı arttıkça yüksek ağırlık değeri atanmıştır. 265,16-300 mm aralığındaki sınıfa 

ağırlık değeri 1 atanırken en çok yağış miktarı olan 375-411,53 mm aralığındaki sınıfa 5 

ağırlık değeri atanmıştır. Etki yüzdesi 25 olarak belirlenmiştir. 

6.1.8. Akarsulara Uzaklık 

Taşkın riskini etkileyen önemli faktörlerden biri de akarsulara uzaklıktır. Akarsu 

yatağına olan uzaklık arttıkça taşkın riski azalmakta olup akarsulara yakın yerlerde ise taşkın 

riski yüksektir. Çalışma alanındaki akarsular Strahler akış sırası yöntemine göre 

sınıflandırılmıştır. 

Hidroloji analizi yapılırken kullanılan DEM verisi üzerinde bulunabilen bazı boşluklar 

“Spatial Analyst Tools→ Hydrology→ Fill” işlemi ile doldurulur. Daha sonra sırasıyla “Flow 

Direction→ Flow Accumulation→ Stream Link→ Stream Order→ Stream To Feature” 

işlemleri yapılır. Daha sonra raster formatına çevrilir. Ardından “Reclassify” işlemi yapılır. 

Çalışma alanı sınırları içerisinde kalan akarsular mesafelerine göre “Geoprocessing→ 

Buffer→ Distance Linear Unit” ile sınıflara ayrıldıktan sonra elde edilen haritada 

“Geoprocessing→ Union” komutu ile tüm sınıflar birleştirilir. Her sınıf tek tek” Conversion 

Tools→ To Raster→ Polygon To Raster” işlemleri ile raster formatına çevrilir. Daha sonra 

“Reclassify” işlemi yapılır. Akarsulara uzaklık haritası Şekil 6.8’de ve sınıflandırılmış 

akarsulara uzaklık ve ağırlık dereceleri Tablo 6.7’de verilmiştir. 
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Şekil 6.8. Akarsulara Uzaklık 

Tablo 6.7. Sınıflandırılmış Akarsulara Uzaklık ve Ağırlık Değerleri 

Akarsulara Uzaklık (m) Alan (km2) Ağırlık Değeri Etki Düzeyi (%) 

0 1511,5955 1 

40 

50 49,1925 5 

100 48,5952 4 

150 48,0576 3 

200 47,3997 2 

250 46,8522 1 

 

Tablo 6.7’de görüldüğü gibi akarsu yatağına olan uzaklık arttıkça taşkın riski 

azalacağından düşük ağırlık değeri atanmıştır. Akarsu yatağına olan mesafe azaldıkça taşkın 

riski de artacağından yüksek ağırlık değeri atanmıştır. Etki yüzdesi 40 olarak belirlenmiştir. 



52 
 

6.2. Yöntem 

Çalışmada ArcGIS 10.2 yazılımı, Çok Kriterli Karar Verme (ÇKKV)  yöntemi ve 

ÇKKV metotlarından Analitik Hiyerarşi Süreci (AHP) kullanılmıştır. 

ArcGIS, harita oluşturmak, mekânsal analiz yapmak ve verileri yönetmek için ESRI 

tarafından geliştirilmiş bir CBS yazılımıdır. Bu çalışmada ArcGIS yazılımında yer alan 

ArcMap kullanılmıştır. 

6.2.1. Çok Kriterli Karar Verme Yöntemi (ÇKKV) 

Forman ve Selly’e göre karar verme, belirli bir amaç doğrultusunda alternatif 

seçenekler arasından seçim yapmaktır (Çınar, 2004). 

ÇKKV, birçok yaklaşımı bünyesinde bulunduran, karar sürecini kriterlere göre birden 

fazla ve aynı anda uygulanan kriterlerin içerisinden elde edeceği faydayı en iyi şekilde analiz 

etme sürecine dayanan karar yöntemidir. Karar vericiler için ele aldığı kriterler içerisinden 

amacına ve probleme uygun olan kriterleri belirlemesinde yardımcı olan yöntemdir. 

Kriterlerin birbiri ile çelişmesi durumunda ortak noktada birleştirilerek değerlendirme 

yapılabilen yöntemdir (Hamurcu ve Eren, 2015). 

Çok kriterli karar verme yönteminde kullanılan parametreler ve ağırlık değerleri o 

bölgenin özelliklerine ve bazı formüllere göre belirlenmektedir bunlar aşağıda anlatıldığı gibi 

belirlenmektedir. Çalışmamda kullanılan parametreler ve ağırlık değerleri ise bu yöntemle 

oluşturulan, literatürde bulunan değerler kullanılarak oluşturulmuştur.  

Problemlerde çözüm için beş adım belirlenmiştir: 

1. Adım: Problem Tanımı: Çözülecek problemin tanımı yapılmalıdır.  

2. Adım: Kriter Belirlenmesi: Karar verme için uygun kriterler oluşturulmalıdır. 

3. Adım: Çözüm İçin Seçenek Oluşturulması: Probleme uygun çözüm seçenekleri 

sunulmalıdır. 

4. Adım: Karar Verme: Sunulan çözüm seçenekleri içerisinden uygun olana karar 

verilmelidir. 

5. Adım: Uygulama: Verilen karar uygulanmalı ve sonuçlar tartışılmalıdır (Özcan 

vd., 2009). 



53 
 

6.2.2. Analitik Hiyerarşi Süreci (AHP) 

AHP, en sık kullanılan ÇKKV yöntemlerindendir. AHP, bütün alternatiflerin her kriter 

için değerlendirilip önem sırasına göre ikili karşılaştırmalar yapılmasıdır. Beş adımda 

gerçekleşir: 

1. Adım: Değerlendirme ölçütleri için ikili karşılaştırma matrisi oluşturulur. 

2. Adım: Karşılaştırılacak matrisin her bir elemanı, bulunduğu sütunun toplamına 

bölünüp normalleştirilmiş karşılaştırma matrisi elde edilir. 

3. Adım: Normalleştirilmiş karşılaştırma matrisi için her satırdaki satır ortalaması 

hesaplandıktan sonra elde edilen ortalama değer kriterlerin önem derecesi 

anlamına gelir. 

4. Adım: Tutarlılık katsayısı yani Consistency Index (CI) hesaplanır. 

ܫܥ =
௠௔௫ߣ − ݊
݊ − 1  

λmax: Ağırlık vektörünün göreli önem derecesine bölünmesi ile bulunur. 

5. Adım: Tutarlılık oranı yani Consistency Rate (CR) hesaplanır. 

ܴܥ =
CI
RI 

RI: Rastgelelik İndeksi 

CR=0 olursa matrisin tamamen tutarlı olduğu anlamına gelir. 

CR<0,1 olursa matris tutarlıdır. 

CR ≥0,1 olursa matris tutarlı oluncaya kadar karşılaştırmaya devam edilir (Aydın vd., 2009). 
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Tablo 6.8. AHP Önem Dereceleri 

Önem Ölçeği Tanım Açıklama 

1 Eşit Eşit önem derecesine sahip iki seçenek 

3 Orta Bir kriter diğerine karşı biraz üstün 

5 Kuvvetli Bir kriter diğerine karşı kuvvetli derecede üstün 

7 Çok kuvvetli Bir kriter diğerine karşı çok kuvvetli derecede üstün  

9 Kesin önemli 
Bir kriter diğerine karşı çok kuvvetli derecede üstün ve 

büyük güvenirliğe sahip 

2, 4, 6, 8 Ara değer İki kriter veya yargı arasındaki değerler 

Kaynak: (Aydın vd., 2009) 

Tablo 6.9. Kriterlerin Karşılaştırılması 

Kriterler Eğim Arazi Kullanımı Sıcaklık Yağış Akarsulara Uzaklık 

Eğim 1 1/2 2 1/3 1/4 

Arazi Kullanımı 2 1 4 2/3 1/2 

Sıcaklık 1/2 1/4 1 1/6 1/8 

Yağış 3 2/3 6 1 3/4 

Akarsulara Uzaklık 4 2 8 1 1/3 1 

 

Bu tez çalışmasında kurulan AHP modelinde CR değeri 0,028 olarak hesaplanmıştır. 

Bu değerin 0,10 değerinden küçük çıkması AHP yönteminin doğruluğu açısından önemlidir. 
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7. SONUÇ VE ÖNERİLER 

Bu çalışmada Uzaktan Algılama ve Coğrafi Bilgi Sistemleri’nden yararlanarak Çok 

Kriterli Karar Verme yöntemi ile Malatya iline ait merkez Battalgazi ve Yeşilyurt ilçelerinin 

taşkın risk haritası oluşturulmuştur. Çalışmada kullanılan her bir kriterin sınıf aralıkları ağırlık 

değerlerine göre Tablo 7.1’de verilmiştir. 

Tablo 7.1. Kriterler ve Atanan Ağırlık Değerleri 

Kriterler Sınıf Aralıkları Ağırlık Değerleri Etki Yüzdesi 

Eğim  (°) 

0-5 5 

10 

5-10 4 
10-15 3 
15-20 2 

20-61,91 1 

Arazi Kullanımı 

Su 1 

20 
Çıplak Arazi 4 

Yeşil Alan 2 

Şehir ve Yapay Yüzey 5 

Sıcaklık (°C) 

12,62-13 5 

5 

13-13,5 4 

13,5-14 3 

14-14,5 2 

14,5-15,57 1 

Yağış (mm) 

265,16-300 1 

25 

300-325 2 

325-350 3 

350-375 4 

375-411,53 5 

Akarsulara Uzaklık (m) 

0 1 

40 

50 5 

100 4 

150 3 

200 2 

250 1 
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Taşkın risk analizi için her kritere ait harita Spatial Analyst Tools→ Overlay→ 

Weighted Overlay ile çakıştırılarak taşkın risk analizi yapılır. Analiz sonucunda elde edilen 

taşkın risk haritası ve alansal dağılım tablosu sırasıyla Şekil 7.1 ve Tablo7.2’de verilmiştir. 

 

Şekil 7.1. Taşkın Risk Haritası 

Tablo 7.2. Risk Sınıfı Alansal Dağılım 

Risk Sınıfı Alan (km2) Yüzde (%) 

Çok Düşük 31,66832598 1,8 
Düşük 1364,014204 78,4 
Orta 284,7566215 16,4 

Yüksek 57,41294355 3,3 
Çok Yüksek 1,650159634 0,1 
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Tablo 7.2’de görüldüğü gibi risk derecesi “Çok Düşük”, “Düşük”, “Orta”, “Yüksek” 

ve “Çok Yüksek” olarak sınıflandırılmıştır. Şekil 7.1’de kırmızı renkler taşkın riskinin “Çok 

Yüksek” olduğu yerleri gösterirken yeşil renkli yerler ise taşkın riskinin “Düşük” olduğu 

yerleri göstermektedir. Haritaya bakıldığında “Yüksek” riskli yerlerin akarsulara yakın yerler 

olduğu görülmektedir. Özelikle yerleşim bölgelerinin yoğun olduğu bölgelerde zemine sızan 

su miktarı azalacağından bu bölgelerde taşkın riski analiz sonucunda “Orta” derecede riskli 

bulunmuştur. Fakat yerleşim bölgelerinden geçen akarsulara yakın yerlerde ise bu risk 

“Yüksek” olarak belirlenmiştir. 

Şekil 7.1’deki taşkın risk haritası ile çalışma alanına ait uydu görüntüleri birlikte ele 

alınarak incelendiğinde akarsu vadisi boyunca yer alan karayolları, tarım arazileri ve en 

önemlisi yerleşim birimleriyle birlikte burada yer alan nüfus yüksek risk altındadır. 

Analiz sonucunda; 

 Horata Çayı çevresi, Konak, Aşağıbağlar, Çilesiz, Gündüzbey, Çırmıhtı, İnönü 

Mah., Çarmuzu, Kaynarca, Selçuklu gibi yerleşim birimleri “Çok Yüksek” risk 

altındaki yerleşim birimleridir. 

 Bostanbaşı, Topsöğüt, Uğrak, Aydoğan, Dilek, Küllü Mağara, Samanköy Kendirli, 

Çırmıhtı, Gündüzbey, Suluköy, Topraktepe, Tepeköy, Şahnahan, Hasırcılar, 

Kemerköprü, Hatunsuyu, Kaynarca, İnönü Mah., Çarmuzu, Orduzu, Eskimalatya, 

Boran, Hanımınçiftliği, Selçuklu, Uçbağlar, Fırat, Çolakoğlu, Karaköy, Fırıncı, 

Özal, Fatih, Görgü gibi yerleşim birimleri “Yüksek” risk altındadır.   

 Merkezden daha uzak birimlerden Yaygın, Kuluşağı, Şişmanhan, Düzyol, Çayköy, 

Bindal, Karahan, Duruldu, Kuşdoğan, Kuyulu “Yüksek” risk altındadır. 

Yerleşim birimlerinden uzakta “Yüksek” risk altında olan tarım arazilerinin sayısı 

oldukça fazladır. Bu durum sadece tarım arazilerinin değil orada yapılan hayvancılığın da 

tehlike altında olduğunu göstermektedir. 

Taşkın tehlikesi altında bulunan yapılar içerisinde konutlar, okullar, sağlık ocakları, 

kamu binaları, camiler,  spor tesisleri, trafolar, akaryakıt istasyonları, hayvan barınakları yer 

almaktadır. Tehlike altında olan yerlerden biri de karayollarıdır. Bazı yolların büyük bir kısmı 

tehlike altında iken bazı yolların da bir bölümü tehlike altında görülmektedir. Bu yapıların 

özellikleri taşkının zararlarını doğrudan ya da dolaylı olarak artırabilir.  Ulaşımın aksaması, 

alt yapı sistemlerinde meydana gelecek hasarlar, kamu, sağlık, sosyal ve eğitim 

hizmetlerindeki aksamalar, elektrik kesintileri de düşünülürse zararının etkisi daha da 
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artacaktır. Toplu kullanılan okul, kamu binaları gibi yapıların zarar görmesi taşkından 

etkilenen nüfusu artıracaktır. Kamu binalarının zarar görmesi acil müdahale, kurtarma gibi 

faaliyetlerin aksamasına yol açacağı için bu binalar risk değerlendirmesinde önem arz 

etmektedir. 

Akarsu yataklarına yerleşim birimlerinin kurulması, altyapı yetersizliği, taşkın 

önlemlerinin yetersiz olması, bitki örtüsünün tahribi gibi nedenler taşkınla meydana gelecek 

hasarı artıracaktır. Ayrıca yaşanan küresel iklim değişikliği düşünülürse önümüzdeki yıllarda 

doğal afetlerin sayısında bir artış meydana geleceği söylenebilir. Bu nedenle doğal afetlerle 

mücadele kapsamında taşkın önleme çalışmaları için risk haritalarının oluşturulması karar 

vericiler için kolaylık sağlayacaktır. Risk haritaları dikkate alınarak planlamaların yapılması 

can ve mal kaybını aza indirecektir. 

Taşkın riskinin yüksek olduğu bölgelerde yapısal ve yapısal olmayan önlemlerin 

alınması tavsiye edilmektedir. Yerleşim birimlerinin bulunduğu yüksek riskli alanlarda 

yapılaşma kontrol altına alınmalıdır. Erken uyarı sistemleri aktif bir şekilde kullanılmalıdır. 

Tehlikenin yüksek olduğu yerlerde nüfusun taşkına hazır olması, müdahale ve planlama 

açısından önemli olup bilgilendirme yapılmalıdır. Taşkın risk planlamasına olumlu katkı 

sağlayacağı düşünülen bu çalışma sosyal ve ekonomik yararlar sağlama konusunda da önem 

arz etmektedir. 

Taşkın risk haritası oluşturmayı amaçlayan bu çalışma, CBS ve UA teknolojilerini bir 

arada kullanarak kısıtlı imkânlar altında taşkın risk haritasının oluşturulabilmesini 

kanıtlamıştır. Ayrıca küresel veri tabanlarıyla birlikte uydu ürünlerinin kullanılması 

çalışmanın özgünlüğünü artırmıştır. Bu bölgede yapılabilecek çalışmalara örnek teşkil etmesi 

tahmin edilen bu tez çalışmasının önemli olduğu düşünülmektedir. CBS, UA ve çalışmada 

kullanılan yöntemler geliştirilerek kullanılabilir. 
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